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C H A P T E R 1
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About the Secure Firewall Migration Tool
This guide contains information on how you can download the Secure Firewall migration tool and complete
the migration. In addition, it provides you troubleshooting tips to help you resolve migration issues that you
may encounter.

The sample migration procedure (Sample Migration: ASA to Threat Defense 2100 ) included in this book
helps to facilitate understanding of the migration process.

The Secure Firewall migration tool converts supported Cisco Secure Firewall ASA configurations to a supported
Secure Firewall Threat Defense platform. The Secure Firewall migration tool allows you to automatically
migrate the supported ASA features and policies to threat defense. You must manually migrate all unsupported
features.

To know more about the commonly used ASA features and their equivalent threat defense features, see Cisco
Secure Firewall ASA to Threat Defense Feature Mapping guide.

The Secure Firewall migration tool gathers ASA information, parses it, and finally pushes it to the Secure
Firewall Management Center. During the parsing phase, the Secure Firewall migration tool generates a
Pre-Migration Report that identifies the following:
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• Cisco Adaptive Security Appliance (ASA) configuration items that are fully migrated, partially migrated,
unsupported for migration, and ignored for migration.

• ASA configuration lines with errors that lists the ASA CLIs which the Secure Firewall migration tool
cannot recognize; this blocks the migration.

If there are parsing errors, you can rectify the issues, reupload a new configuration, connect to the destination
device, map the ASA interfaces to threat defense interfaces, map security zones and interface groups, and
proceed to review and validate your configuration. You can then migrate the configuration to the destination
device.

Console

The console opens when you launch the Secure Firewall migration tool. The console provides detailed
information about the progress of each step in the Secure Firewall migration tool. The contents of the console
are also written to the Secure Firewall migration tool log file.

The console must stay open while the Secure Firewall migration tool is open and running.

When you exit the Secure Firewall migration tool by closing the browser on which the web interface is running,
the console continues to run in the background. To completely exit the Secure Firewall migration tool, exit
the console by pressing the Command key + C on the keyboard.

Important

Logs

The Secure Firewall migration tool creates a log of each migration. The logs include details of what occurs
at each step of the migration and can help you determine the cause if a migration fails.

You can find the log files for the Secure Firewall migration tool in the following location:
<migration_tool_folder>\logs

Resources

The Secure Firewall migration tool saves a copy of the Pre-Migration Reports, Post-Migration Reports,
ASA configs, and logs in the Resources folder.

You can find the Resources folder in the following location: <migration_tool_folder>\resources

Unparsed File

You can find the unparsed file in the following location:

<migration_tool_folder>\resources

Search in the Secure Firewall Migration Tool

You can search for items in the tables that are displayed in the Secure Firewall migration tool, such as those
on the Optimize, Review and Validate page.

To search for an item in any column or row of the table, click the Search ( ) above the table and enter the
search term in the field. The Secure Firewall migration tool filters the table rows and displays only those that
contain the search term.

Migrating Cisco Secure Firewall ASA to Cisco Secure Firewall Threat Defense with the Migration Tool
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To search for an item in a single column, enter the search term in the Search field that is provided in the
column heading. The Secure Firewall migration tool filters the table rows and displays only those that match
the search term.

Ports

The Secure Firewall migration tool supports telemetry when run on one of these 12 ports: ports 8321-8331
and port 8888. By default, Secure Firewall migration tool uses port 8888. To change the port, update port
information in the app_config file. After updating, ensure to relaunch the Secure Firewall migration tool for
the port change to take effect. You can find the app_config file in the following location:
<migration_tool_folder>\app_config.txt.

We recommend that you use ports 8321-8331 and port 8888, as telemetry is only supported on these ports. If
you enable Cisco Success Network, you cannot use any other port for the Secure Firewall migration tool.

Note

Notifications Center

All the notifications, including success messages, error messages, and warnings that pop up during a migration
are captured in the notifications center and are categorized as Successes, Warnings, and Errors. You can

click the icon on the top right corner any time during the migration and see the various notifications
that popped up, along with the time they popped up in the tool.

Cisco Success Network

Cisco Success Network is a user-enabled cloud service. When you enable Cisco Success Network, a secure
connection is established between the Secure Firewall migration tool and the Cisco cloud to stream usage
information and statistics. Streaming telemetry provides a mechanism to select data of interest from the Secure
Firewall migration tool and to transmit it in a structured format to remote management stations for the following
benefits:

• To inform you of available unused features that can improve the effectiveness of the product in your
network.

• To inform you of additional technical support services and monitoring that is available for your product.

• To help Cisco improve our products.

The Secure Firewall migration tool establishes and maintains the secure connection and allows you to enroll
in the Cisco Success Network. You can turn off this connection at any time by disabling the Cisco Success
Network, which disconnects the device from the Cisco Success Network cloud.
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What’s New in the Secure Firewall Migration Tool
Supported FeaturesVersion

This release includes the following new features and enhancements:

Cisco Secure Firewall ASA to Cisco Secure Firewall Threat Defense Migration

• You can now configure a threat defense high availability (HA) pair on the
target management center and migrate configurations from a Secure Firewall
ASA HA pair to the management center. Choose Proceed with HA Pair
Configuration on the Select Target page and choose an active and a standby
device. When selecting the active threat defense device, ensure you have an
identical device on the management center for the HA pair configuration to be
successful. See Specify Destination Parameters for the Secure Firewall
Migration Tool in the Migrating Cisco Secure Firewall ASA to Cisco Secure
Firewall Threat Defense with the Migration Tool book for more information.

• You can now configure a site-to-site hub and spoke VPN topology using threat
defense devices when migrating site-to-site VPN configurations from an ASA
device. Click Add Hub & Spoke Topology under Site-to-Site VPN Tunnels
on the Optimize, Review and Validate Configuration page. See Optimize,
Review, and Validate the Configuration in theMigrating Cisco Secure Firewall
ASA to Cisco Secure Firewall Threat Defense with the Migration Tool book
for more information.

Fortinet Firewall to Cisco Secure Firewall Threat Defense Migration

• You can now migrate IPv6 and multiple interface and interface zones in SSL
VPN and central SNAT configurations from a Fortinet firewall to your threat
defense device. See Fortinet Configuration Support in Migrating Fortinet
Firewall to Cisco Secure Firewall Threat Defense with the Migration Tool
book for more information.

7.0
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Supported FeaturesVersion

This release includes the following new features and enhancements:

Cisco Secure Firewall ASA to Cisco Secure Firewall Threat Defense Migration

• You can now optimize network and port objects when you migrate
configurations from Secure Firewall ASA to threat defense. Review these
objects in their respective tabs in the Optimize, Review and Validate
Configuration page and click Optimize Objects and Groups to optimize
your list of objects before migrating them to the target management center.
The migration tool identifies objects and groups that have the same value and
prompts you to choose which to retain. See Optimize, Review, and Validate
the Configuration for more information.

FDM-managed Device to Cisco Secure Firewall Threat Defense Migration

• You can now migrate DHCP, DDNS, and SNMPv3 configurations from your
FDM-managed device to a threat defense device. Ensure you check theDHCP
checkbox and Server, Relay, and DDNS checkboxes on the Select Features
page. See Optimize, Review, and Validate the Configuration for more
information.

Fortinet Firewall to Cisco Secure Firewall Threat Defense Migration

• You can now migrate URL objects in addition to other object types from a
Fortinet firewall to your threat defense device. Review the URL Objects tab
in the Objects window in Optimize, Review and Validate Configuration
page during migration. See Optimize, Review, and Validate the Configuration
for more information.

Palo Alto Networks Firewall to Cisco Secure Firewall Threat Defense Migration

• You can now migrate URL objects in addition to other object types from a
Palo Alto Networks firewall to your threat defense device. Ensure you review
the URL Objects tab in the Objects window in Optimize, Review and
Validate Configuration page during migration. See Optimize, Review, and
Validate the Configuration for more information.

Check Point Firewall to Cisco Secure Firewall Threat Defense Migration

• You can now migrate port objects, FQDN objects, and object groups from a
Check Point Firewall to your threat defense device. Review theObjectswindow
in Optimize, Review and Validate Configuration page during migration.
See Optimize, Review, and Validate the Configuration for more information.

6.0.1
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Supported FeaturesVersion

This release includes the following new features and enhancements:

Cisco Secure Firewall ASA to Cisco Secure Firewall Threat Defense Migration

• You can now migrate WebVPN configurations on your Secure Firewall ASA
to Zero Trust Access Policy configurations on a threat defense device. Ensure
that you check the WebVPN checkbox in Select Features page and review
the new WebVPN tab in the Optimize, Review and Validate Configuration
page. The threat defense device and the target management center must be
running on Version 7.4 or later and must be operating Snort3 as the detection
engine.

• You can now migrate Simple Network Management Protocol (SNMP) and
Dynamic Host Configuration Protocol (DHCP) configurations to a threat
defense device. Make sure that you check the SNMP and DHCP checkboxes
in the Select Features page. If you have configured DHCP on your Secure
Firewall ASA, note that the DHCP server, or relay agent and DDNS
configurations can also be selected to be migrated.

• You can nowmigrate the equal-cost multipath (ECMP) routing configurations
when performing amulti-context ASA device to a single-instance threat defense
merged context migration. TheRoutes tile in the parsed summary now includes
ECMP zones also, and you can validate the same under the Routes tab in the
Optimize, Review and Validate Configuration page.

• You can nowmigrate dynamic tunnels from the dynamic virtual tunnel interface
(DVTI) configurations from your Secure Firewall ASA to a threat defense
device. You can map them in the Map ASA Interfaces to Security Zones,
Interface Groups, and VRFs page. Ensure that your ASA Version is 9.19
(x) and later for this feature to be applicable.

FDM-managed Device to Cisco Secure Firewall Threat Defense Migration

• You can nowmigrate the Layer 7 security policies including SNMP and HTTP,
and malware and file policy configurations from your FDM-managed device
to a threat defense device. Ensure that the target management center Version
is 7.4 or later and that Platform Settings and File and Malware Policy
checkboxes in Select Features page are checked.

Check Point Firewall to Cisco Secure Firewall Threat Defense Migration

• You can now migrate the site-to-site VPN (policy-based) configurations on
your Check Point firewall to a threat defense device. Note that this feature
applies to Check Point R80 or later versions, and management center and threat
defense Version 6.7 or later. Ensure that the Site-to-Site VPN Tunnels
checkbox is checked in the Select Features page. Note that, because this is a
device-specific configuration, the migration tool does not display these
configurations if you choose to Proceed without FTD.

Fortinet Firewall to Cisco Secure Firewall Threat Defense Migration

• You can now optimize your application access control lists (ACLs) when
migrating configurations from a Fortinet firewall to your threat defense device.

Migrating Cisco Secure Firewall ASA to Cisco Secure Firewall Threat Defense with the Migration Tool
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Supported FeaturesVersion

Use the Optimize ACL button in the Optimize, Review and Validate
Configuration page to see the list of redundant and shadow ACLs and also
download the optimization report to see detailed ACL information.

This release includes the following new features and enhancements:

• The Secure Firewall migration tool now supports migration of multiple
transparent firewall-mode security contexts from Secure Firewall ASA devices
to threat defense devices. You canmerge two or more transparent firewall-mode
contexts that are in your Secure Firewall ASA device to a transparent-mode
instance and migrate them.

In a VPN-configured ASA deployment where one or more of your contexts
have VPN configurations, you can choose only one context whose VPN
configuration you want to migrate to the target threat defense device. From
the contexts that you have not selected, only the VPN configuration is ignored
and all other configurations are migrated.

See Select the ASA Security Context for more information.

• You can now migrate site-to-site and remote access VPN configurations from
your Fortinet and Palo Alto Networks firewalls to threat defense using the
Secure Firewall migration tool. From the Select Features pane, select the VPN
features that you want to migrate. See the Specify Destination Parameters for
the Secure Firewall Migration Tool section in Migrating Palo Alto Networks
Firewall to Secure Firewall Threat Defense with the Migration Tool and
Migrating Fortinet Firewall to Secure Firewall Threat Defense with the
Migration Tool guides.

• You can now select one or more routed or transparent firewall-mode security
contexts from your Secure Firewall ASA devices and perform a single-context
or multi-context migration using the Secure Firewall migration tool.

5.0.1
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Supported FeaturesVersion

• Secure Firewall migration tool now supports migration of multiple security
contexts from Secure Firewall ASA to threat defense devices. You can choose
to migrate configurations from one of your contexts or merge the configurations
from all your routed firewall mode contexts and migrate them. Support for
merging configurations from multiple transparent firewall mode contexts will
be available soon. See Select the ASA Primary Security Context for more
information.

• The migration tool now leverages the virtual routing and forwarding (VRF)
funtionality to replicate the segregated traffic flow observed in a multi-context
ASA environment, which will be part of the new merged configuration. You
can check the number of contexts the migration tool has detected in a new
Contexts tile and the same after parsing, in a new VRF tile in the Parsed
Summary page. In addition, the migration tool displays the interfaces to which
these VRFs are mapped, in the Map Interfaces to Security Zones and
Interface Groups page.

• You can now try the whole migration workflow using the new demo mode in
Secure Firewall migration tool and visualize how your actual migration looks
like. See Using the Demo Mode in Firewall Migration Tool for more
information.

• With new enhancements and bug fixes in place, Secure Firewall migration tool
now provides an improved, faster migration experience for migrating Palo
Alto Networks firewall to threat defense.

5.0

The Secure Firewall migration tool 4.0.3 includes bug fixes and the following new
enhancements:

• The migration tool now offers an enhanced Application Mapping screen for
migrating PAN configurations to threat defense. See Map Configurations with
Applications in Migrating Palo Alto Networks Firewall to Secure Firewall
Threat Defense with the Migration Tool guide for more information.

4.0.3

The Secure Firewall migration tool 4.0.2 includes the following new features and
enhancements:

• Secure Firewall migration tool now supports migration of site-to-site VPN
filter configurations and the extended access list objects pertaining to those
configurations when the destination management center and threat defense
versions are 7.1 and later. Earlier, site-to-site VPN filter configurations were
not migrated and had to be manually configured after migration.

• The migration tool now has an always-on telemetry; however, you can now
choose to send limited or extensive telemetry data. Limited telemetry data
inludes few data points, whereas extensive telemetry data sends a more detailed
list of telemetry data. You can change this setting from Settings > Send
Telemetry Data to Cisco?.

4.0.2
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The Secure Firewall migration tool 4.0.1 includes the following new features and
enhancements:

The Secure Firewall migration tool now analyzes all objects and object groups based
on both their name and configuration, and reuses objects that have the same name
and configuration. Only network objects and network object groups were analyzed
based on their name and configuration before. Note that the XML profiles in remote
access VPNs are still validated only using their name.

4.0.1

Secure Firewall migration tool 4.0 supports:

• Migration of Policy Based Routing (PBR) from ASA if the destination
management center and threat defense version are 7.3 and later.

For PBR migration, the existing flex configuration must be removed
from the management center before proceeding with the migration.

Note

• Migration of Remote Access VPN custom attributes and VPN load balancing
from ASA if the destination management center is 7.3 or later.

You can perform Remote Access VPN migration with or without a firewall.
However, if you chose to perform the migration with a firewall, then the threat
defense version must be 7.0 and later.

To migrate Remote Access VPN with a targeted firewall, you must
select the target firewall and add any one of the following licenses to
the targeted firewall:

Note

• AnyConnect Plus

• AnyConnect Apex

• AnyConnect VPN Only

• Migration of Equal CostMulti-Path (ECMP) routes fromASA if the destination
management center is 7.1 and later and the threat defense version is 6.5 and
later.

4.0

The Secure Firewall Migration Tool 3.0.2 includes bug fixes for remote access VPN
configuration migration from ASA to Management Center versions 7.2 or higher.

3.0.2

Secure Firewall Migration Tool 3.0.1 supports:

• Migration of Enhanced Interior Gateway Routing Protocol (EIGRP) fromASA
if the destination management center is version 7.2 and later and the threat
defense version is 7.0 and later.

You cannot migrate EIGRP from ASA and ASA with FirePOWER
Services without a threat defense device.

Note

• The Cisco Secure Firewall 3100 series is supported as a source or destination
device for migrations from ASA.

3.0.1
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The Secure Firewall migration tool 3.0 supports:

• Remote Access VPNmigration fromASA if the destinationmanagement center
is 7.2 or later. You can perform RA VPN migration with or without Secure
Firewall Threat Defense. If you select the migration with threat defense, then
the threat defense version must be 7.0 or later.

• Site-to-Site VPN pre-shared key automation from ASA.

• The following must be performed as part of the pre-migration activity:

• The ASA trustpoints must bemanuallymigrated to themanagement center
as PKI objects.

• AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan
Package), External Browser package, and AnyConnect profiles must be
retrieved from source ASA.

• AnyConnect packages must be uploaded to the management center.

• AnyConnect profiles must be directly uploaded to the management center
or from the Secure Firewall migration tool.

• The ssh scopy enable command must be enabled on the ASA to allow
retrieval of profiles from the Live Connect ASA.

• Migration to Cloud-delivered Firewall Management Center from ASA if the
destination management center is 7.2 or later.

3.0

The Secure Firewall migration tool 2.5.2 provides support to identify and segregate
ACLs that can be optimized (disabled or deleted) from the firewall rule base without
impacting the network functionality from Firewalls.

The ACL Optimization supports the following ACL types:

• Redundant ACL—When two ACLs have the same set of configurations and
rules, then removing the non-base ACL will not impact the network.

• Shadow ACL—The first ACL completely shadows the configurations of the
second ACL.

Optimization is available for the ASA only for ACP rule action.Note

The Secure Firewall migration tool 2.5.2 supports Border Gateway Protocol (BGP)
and Dynamic-Route Objects migration if the destination management center is 7.1
or later.

2.5.2

The Secure Firewall migration tool 2.5.1 supports Border Gateway Protocol (BGP)
and Dynamic-Route Objects migration if the destination management center is 7.1
or later.

2.5.1
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The Secure Firewall migration tool 2.5 provides support to identify and segregate
ACLs that can be optimized (disabled or deleted) from the firewall rule base without
impacting the network functionality.

The ACL Optimization supports the following ACL types:

• Redundant ACL: When two ACLs have the same set of configurations and
rules, then removing the non-base ACL will not impact the network.

• Shadow ACL: The first ACL completely shadows the configurations of the
second ACL.

Optimization is available for the Source ASA only for ACP rule action.Note

Discontinuous networkmask (Wildcardmask) objects are supported if the destination
management center version is 7.1 or later.

2.5

The following ASA VPN configuration migration to threat defense:

• Crypto map (static/dynamic) based VPN from ASA

• Route-based (VTI) based ASA VPN

• Certificate-based VPN migration from ASA

Note • ASA trustpoint or certificates is migrated manually and part of
pre-migration activity.

• ASA trustpoint must be migrated as management center PKI objects.
PKI objects are used in Secure Firewall migration tool while creating
certificate-based VPN topologies.

2.4

The Secure Firewall migration tool supports the migration of the following Virtual
Tunnel Interface (VTI) configurations to threat defense if the target management
center and threat defense is 6.7 or later:

• VTI interface and the related static routes

• Route-based (VTI) pre-shared key authentication type VPN configuration to
management center and threat defense.

• Create routed security zone, add VTI interfaces, and then define access control
rules for the decrypted traffic control over VTI tunnel.

2.3.5
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The Secure Firewall migration tool allows you to migrate the following ASA VPN
configuration elements to threat defense:

• Supports migration of policy-based (crypto map) pre-shared key authentication
type VPN configuration to the management center.

• VPN Objects—Creates VPN Objects (IKEv1/IKEv2 Policy, IKEv1/IKEv2
IPsec-Proposal), maps the VPN objects with the specific Site-to-Site VPN
topologies, and migrates the objects to the management center.

Verify the VPN objects against the rules in the Review and Validate
Configuration page.

• Site-to-Site VPN Topology—The crypto map related configurations in source
ASA config are migrated with respective VPN objects. Policy-based (crypto
map) VPN Topology are supported on management center version 6.6 and
above.

In this release, Secure Firewall migration tool supports migration of
static crypto map only.

All supported ASA crypto map VPNwill be migrated as management
center point-to-point topology.

Note

2.3.4
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• The Secure Firewall migration tool allows you to connect to an ASA using the
admin credentials and Enable Password as configured on the ASA.

If ASA is not configured withEnable Password, you can leave the field blank
on the Secure Firewall migration tool.

• You can now configure the batch size limit for Bulk Push in the app_config
file as follows:

• For Objects, the batch size cannot exceed 500. The Secure Firewall
migration tool resets the value to 50 and proceeds with the bulk push.

• For ACLs, Routes, and NAT, the batch size cannot exceed 1000 each.
The Secure Firewall migration tool resets the value to 1000 and proceeds
with the bulk push.

• The Secure Firewall migration tool allows you to parse the CSM or ASDM
managed configurations.

When you opt to clear the inline grouping or ASDMmanaged configurations,
the predefined objects are replaced with the actual object or member name.

If you do not clear the CSM or ASDMmanaged configurations, the predefined
object names will be retained for migration.

• Provides customer support to download log files, dB, and configuration files
during a migration failure. You can also raise a support case with the technical
team through an email.

• Support for migration of IPv6 configurations in Objects, Interfaces, ACL,
NAT, and Routes.

• The Secure Firewall migration tool allows you to map an ASA interface name
to a physical interface on the threat defense object types—Physical interfaces,
port channel, and subinterfaces. For example, you can map a port channel in
ASA to a physical interface in management center.

• The Secure Firewall migration tool provides support to skip migration of the
selected NAT rules and Route interfaces. The previous versions of the Secure
Firewall migration tool provided this option for Access Control rules only.

• You can download the parsed Access Control, NAT, Network Objects, Port
Objects, Interface, and Routes configuration items from theOptimize, Review
and Validate Configuration screen in an excel or CSV format.

You cannot import a CSV file.Note

1.3
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• Supports migration to management center 6.3

• Supports migration of IPv4 FQDN Objects and Groups

• Supports the show tech-support command in the manual upload method for
Multiple-Context ASA

• Supports migration to the container type threat defense (MI) registered on
management center.

• Rule Action Mapping Support (Allow, Trust, Monitor, Block, or Block with
Reset) on the migrated access control rules in the Access Control table.

• Version check for Secure Firewall migration tool to ensure that you are using
the most recent version of the Secure Firewall migration tool.

1.2

• Bulk push for objects, NAT, static routes significantly reduce the time that is
taken to push the configuration to a management center.

• Extracting configuration from a production ASA

• Selective feature migration (shared policy and device-specific policy)

• Rule optimization

• Map migrating ASA Access Control Rules to a list of configured Intrusion
Prevention System and File Policies on the management center.

• Migrate only those objects that are referenced in policies. This optimizes
migration times and cleans out unused objects during configuration.

• Migration support for running-config or sh run from one of Data Contexts
of ASA running in multiple-context mode.

• Support on macOS version 10.13 and higher

• Support to modify logging actions (enable or disable, logging at beginning or
end) for migrated Access Control Rules.

• Migration to threat defense devices configured within domains on the
management center.

• Bulk edits capability for object names.

• Telemetry support with Cisco Success Network

1.1
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• Validation throughout the migration, including parse and push operations.

• Object re-use capability

• Object conflict resolution

• Interface mapping

• Autocreation or reuse of interface objects (ASA name if to the security zone
and interface group mapping)

• Support for a bulk migration of ACLs

1.0

Licensing for the Secure Firewall Migration Tool
The Secure Firewall migration tool application is free and does not require license. However, the management
center must have the required licenses for the related threat defense features to successfully register threat
defense devices and deploy policies to it.

Platform Requirements for the Secure Firewall Migration Tool
The Secure Firewall migration tool has the following infrastructure and platform requirements:

• Runs on a Microsoft Windows 10 64-bit operating system or on a macOS version 10.13 or higher

• Has Google Chrome as the system default browser

• (Windows) Has Sleep settings configured in Power & Sleep to Never put the PC to Sleep, so the system
does not go to sleep during a large migration push

• (macOS) Has Energy Saver settings configured so that the computer and the hard disk do not go to sleep
during a large migration push

Requirements and Prerequisites for the ASA Configuration File
You can obtain an ASA configuration file either manually or by connecting to a live ASA from the Secure
Firewall migration tool.

The ASA configuration file that you manually import into the Secure Firewall migration tool must meet the
following requirements:

• Has a running configuration that is exported from an ASA device in a single mode configuration or
specific context of a multiple context mode configuration. See Export the ASA Configuration File, on
page 36.

• Includes the version number.

• Contains only valid ASA CLI configurations.

• Does not contain syntax errors.
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• Has a file extension of .cfg or .txt.

• Uses a file encoding of UTF-8.

• Has not been hand coded or manually altered. If you modify the ASA configuration, we recommend that
you test the modified configuration file on the ASA device to ensure that it is a valid configuration.

• Does not contain the "--More--" keyword as text.

Requirements and Prerequisites for Threat Defense Devices
When you migrate to the management center, it may or may not have a target threat defense device added to
it. You can migrate shared policies to a management center for future deployment to a threat defense device.
To migrate device-specific policies to a threat defense, you must add it to the management center. As you
plan tomigrate your ASA configuration to threat defense, consider the following requirements and prerequisites:

• The target threat defense device must be registered with the management center.

• The threat defense device can be a standalone device or a container instance. It must not be part of a
cluster or a high availability configuration.

• The target native threat defense device must have at least an equal number of used physical data
and port channel interfaces (excluding ‘management-only’ and subinterfaces) as that of the ASA;
if not you must add the required type of interface on the target threat defense device. Subinterfaces
are created by the Secure Firewall migration tool that are based on physical or port channel mapping.

• If the target threat defense device is a container instance, at minimum it must have an equal number
of used physical interfaces, physical subinterfaces, port channel interfaces, and port channel
subinterfaces (excluding ‘management-only’) as that of the ASA; if not you must add the required
type of interface on the target threat defense device.

• Subinterfaces are not created by the Secure Firewall migration tool, only
interface mapping is allowed.

• Mapping across different interface types is allowed, for example: physical
interface can be mapped to a port channel interface.

Note

ASA Configuration Support
Supported ASA Configurations

The Secure Firewall migration tool can fully migrate the following ASA configurations:

• Network objects and groups

• Service objects, except for those service objects configured for a source and destination
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Though the Secure Firewall migration tool does not migrate extended service
objects (configured for a source and destination), referenced ACL and NAT rules
are migrated with full functionality.

Note

• Service object groups, except for nested service object groups

Since nesting is not supported on the management center, the Secure Firewall
migration tool expands the content of the referenced rules. The rules, however,
are migrated with full functionality.

Note

• IPv4 and IPv6 FQDN objects and groups

• IPv6 conversion support (Interface, Static Routes, Objects, ACL, and NAT)

• Access rules that are applied to interfaces in the inbound direction and global ACL

• Auto NAT, Manual NAT, and object NAT (conditional)

• Static routes, ECMP routes, and PBR

• DHCP configurations including server, relay, and DDNS

• SNMP

• Physical interfaces

• Secondary VLANs on ASA interfaces are not migrated to threat defense.

• Subinterfaces (subinterface ID is always set to the same number as the VLAN ID on migration)

• Port channels

• Virtual tunnel interface (VTI)

• Dynamic VTI and IPv6

• Bridge groups (transparent mode only)

• IP SLA Monitor

The Secure Firewall migration tool creates IP SLA Objects, maps the objects with the specific static
routes, and migrates the objects to management center.

IP SLA monitor defines a connectivity policy to a monitored IP address and tracks the availability of a
route to the IP address. The static routes are periodically checked for availability by sending ICMP echo
requests and waiting for the response. If the echo requests are timed-out, the static routes are removed
from the routing table and replaced with a backup route. SLA monitoring jobs start immediately after
deployment and continue to run unless, you remove the SLAmonitor from the device configuration, that
is, they do not age out. The IP SLAmonitor objects are used in the Route Tracking field of an IPv4 static
route policy. IPv6 routes do not have the option to use SLA monitor through route tracking.
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IP SLA Monitor is not supported for non-threat defense flow.Note

• Object Group Search

Enabling object group search reduces memory requirements for access control policies that include
network objects. We recommend you to enable object group search that enhances optimal memory
utilization by access policy on threat defense.

• Object Group Search is unavailable for management center or threat defense
version earlier than 6.6.

• Object Group Search will not be supported for non-threat defense flow and
will be disabled.

Note

• Time-based objects

When the Secure Firewall migration tool detects time-based objects that are referenced with access-rules,
the Secure Firewall migration tool migrates the time-based objects and maps them with respective
access-rules. Verify the objects against the rules in the Review and Validate Configuration page.

Time-based objects are access-list types that allow network access on the basis of time period. It is useful
when you must place restrictions on outbound or inbound traffic on the basis of a particular time of the
day or particular days of a week.

• You must manually migrate timezone configuration from source ASA to
target FTD.

• Time-based object is not supported for non-threat defense flow and will be
disabled.

• Time-based objects are supported on management center version 6.6 and
above.

Note

• Site-to-Site VPN Tunnels

• Site-to-Site VPN—When the Secure Firewall migration tool detects crypto map configuration in
the source ASA, the Secure Firewall migration tool migrates the crypto map to the management
center VPN as point-to-point topology.

• Crypto map (static/dynamic) based VPN from ASA

• Route-based (VTI) ASA VPN

• Certificate-based VPN migration from ASA

• ASA trustpoint or certificates migration to the management center must be performed manually and
is part of the pre-migration activity.
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• Dynamic-Route Objects, BGP, and EIGRP

• Policy-List

• Prefix-List

• Community List

• Autonomous System (AS)-Path

• Remote Access VPN

• SSL and IKEv2 protocol

• Authentication methods—AAA only, Client Certificate only, SAML, AAA, and Client Certificate

• AAA—Radius, Local, LDAP, and AD

• Connection Profiles, Group-Policy, Dynamic Access Policy, LDAP Attribute Map, and Certificate
Map

• Standard and Extended ACL

• RA VPN Custom Attributes and VPN load balancing

• As part of pre-migration activity, perform the following:

• Migrate the ASA trustpoints manually to the management center as PKI objects.

• Retrieve AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan Package),
External Browser package, and AnyConnect profiles from the source ASA.

• Upload all AnyConnect packages to the management center.

• Upload AnyConnect profiles directly to the management center or from the Secure Firewall
migration tool.

• Enable the ssh scopy enable command on the ASA to allow retrieval of profiles from the Live
Connect ASA.

• WebVPN

• Group security policies SSL clientless VPN tunnel protocols

• Tunnel groups related to group policies that use Security Assertion Markup Language (SAML) as
the authentication method

• Tunnel groups containing HTTPS-based application URLs

If the aforementioned criteria are met, the SAML configurations and application
URLs are migrated.

Note
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Partially Supported ASA Configurations

The Secure Firewall migration tool partially supports the following ASA configurations for migration. Some
of these configurations include rules with advanced options that are migrated without those options. If the
management center supports those advanced options, you can configure them manually after the migration is
complete.

• Access control policy rules that are configured with advanced logging settings, such as severity and
time-interval.

• Static routes that are configured with the track option.

• Certificate-based VPN migration.

• Dynamic-Route Objects, EIGRP, and BGP

• Route-Map

Unsupported ASA Configurations

The Secure Firewall migration tool does not support the following ASA configurations for migration. If these
configurations are supported in the management center, you can configure them manually after the migration
is complete.

• SGT-based access control policy rules

• SGT-based objects

• User-based access control policy rules

• NAT rules that are configured with the block allocation option

• Tunneling protocol-based access control policy rules

Support with a prefilter on Secure Firewall migration tool and management center
6.5.

Note

• NAT rules that are configured with SCTP

• NAT rules that are configured with host ‘0.0.0.0’

• Default route obtained through DHCP or PPPoE with SLA tracking

• SLA monitor schedule

• Transport mode IPsec transform-set

• ASA trustpoint migration into management center

• Transparent firewall mode for BGP

• In an ASAWebVPN to Zero Trust Application (ZTA) policy migration, the following are not supported:

• Importing WebVPN bookmarks

• Local, RADIUS, and LDAP authentication methods
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• Access list remarks

Guidelines and Limitations
During conversion, the Secure Firewall migration tool creates a one-to-one mapping for all supported objects
and rules, whether they are used in a rule or policy. The Secure Firewall migration tool provides an optimization
feature that allows you to exclude migration of unused objects (objects that are not referenced in any ACLs
and NATs).

The Secure Firewall migration tool deals with unsupported objects and rules as follows:

• Unsupported objects and NAT rules are not migrated.

• Unsupported ACL rules are migrated as disabled rules into the management center.

• Outbound ACLs are unsupported and will not be migrated to management center. If the source firewall
has outbound ACLs, it will be reported in the ignored section of the Pre-Migration Report.

• All supported ASA crypto map VPN will be migrated as management center point-to-point topology.

• Unsupported or incomplete static crypto map VPN topologies are not migrated.

• In an ASA multicontext to a single instance threat defense migration, the equal-cost multipath (ECMP)
routing configurations are migrated to the corresponding virtual routing and forwarding (VRF)
configurations:

• Interfaces in two different security contexts with the same name are renamed by adding an underscore
and the context name.

• Security zones in two different security contexts with the same name are renamed by adding an
underscore and the context name.

• If ECMP routing configurations are present with VPN configurations, they are migrated to the global
router (global VRF).

ASA Configuration Limitations

Migration of your source ASA configuration has the following limitations:

• The Secure Firewall migration tool supports migrating individual security contexts from the ASA as
separate threat defense devices.

• The system configuration is not migrated.

• The Secure Firewall migration tool does not support migration of a single ACL policy that is applied to
over 50 interfaces. Manually migrate ACL policies that are applied to 50 or more interfaces.

• You cannot migrate some ASA configurations, for example, dynamic routing to threat defense. Migrate
these configurations manually.

• You cannot migrate ASA devices in routedmodewith a bridge virtual interface (BVI), redundant interface,
or tunneled interface. However, you can migrate ASA devices in transparent mode with BVI.
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• Nested service object-groups or port groups are not supported on the management center. As part of
conversion, the Secure Firewall migration tool expands the content of the referenced nested object-group
or port group.

• The Secure Firewall migration tool splits the extended service object or groups with source and destination
ports that are in one line into different objects across multiple lines. References to such access control
rules are converted into management center rules with the exact same meaning.

• If the source ASA configuration has access control rules that do not refer to specific tunneling protocols
(like GRE, IP-in-IP and IPv6-in-IP), but these rules match unencrypted tunnel traffic on the ASA, then,
on migration to the threat defense, the corresponding rules will not behave in the same way they do on
the ASA. We recommend that you create specific tunnel rules for these in the Prefilter policy, on the
threat defense.

• Supported ASA crypto map will be migrated as point-to-point topology.

• If an AS-Path object with the same name in management center appears, then the migration stops with
the following error message:

"Conflicting AS-Path object name detected in management center, please resolve conflict in management
center to proceed further"

• Redistribution from OSPF and Routing Information Protocol (RIP) into EIGRP is not supported.

• For PBR, ASA configuration has route-maps whereas management center does not use route-maps. The
Secure Firewall migration tool migrates the configuration inside a route-map applied to an interface.

• For route-maps with multiple sequence numbers, only the first sequence number will be migrated. All
other sequence numbers will be ignored and shown in the pre-migration report.

Limitations for RA VPN Migration

Remote Access VPN migration is supported with the following limitations:

• SSL settings migration is not supported due to API limitations.

• LDAP server is migrated with encryption type as "none".

• DfltGrpPolicy is not migrated as the policy is applicable for the entire management center. You can make
the necessary changes directly on the management center.

• For a radius server, if dynamic authorization is enabled, the AAA server connectivity should be through
an interface and not dynamic routing. If ASA configuration is found with AAA server with dynamic
authorization enabled without interface, the Secure Firewall migration tool ignores dynamic authorization.
You must enable dynamic-authorization manually after selecting an interface on the management center.

• ASA configuration can have an interface while calling address pool under tunnel-group. But the same
is not supported on the management center. If there an interface is detected in the ASA configuration it
is ignored by the Secure Firewall migration tool and the address pool is migrated without the interface.

• ASA configuration can have keyword link-selection/subnet-selection for dhcp-server under tunnel
group. But the same is not supported on the management center. If a dhcp server is detected in the ASA
configuration with these keywords, it is ignored by the Secure Firewall migration tool and the dhcp-server
is pushed without the keywords.

• ASA configuration can have an interface while calling authentication server group, secondary
authentication server group, authorization server group under tunnel group. But the same is not supported
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on the management center. If an interface is detected in the ASA configuration it is ignored by the Secure
Firewall migration tool and the commands are pushed without the interface.

• ASA configuration does not map Redirect ACL to a radius server. Thus, there is no way to retrieve it
from the Secure Firewall migration tool. If redirect ACL is used in the ASA, it is left empty, and you
must add and map it manually on the management center.

• ASA supports value from 0-720 for vpn-addr-assign local reuse delay. But the management center
supports value from 0-480. If a value higher than 480 is found in the ASA configuration, it is set to
maximum supported value 480 on the management center.

• Configuring IPv4 pool and DHCP useSecondaryUsernameforSession settings to the connection profile
is not supported due to API issues.

• Bypass access control sysopt permit-vpn option is not enabled under RA VPN policy. However, if
required, you can enable it from the management center.

• AnyConnect client module and profile values can be updated under group policy only when the profiles
are uploaded from Secure Firewall migration tool to the management center.

• You need to map the certificates directly on the management center.

• IKEv2 parameters are not migrated by default. You must add them through the management center.

ASA Migration Guidelines

The migration of the ACL log option follows the best practices for threat defense. The log option for a rule
is enabled or disabled based on the source ASA configuration. For rules with an action of deny, the Secure
Firewall migration tool configures logging at the beginning of the connection. If the action is permit, the
Secure Firewall migration tool configures logging at the end of the connection.

Object Migration Guidelines

ASA and threat defense have different configuration guidelines for objects. For example, one or more objects
can have the same name in ASA with one object name in lowercase and the other object name in uppercase,
but each object must have a unique name, regardless of case, in threat defense. To accommodate such
differences, the Secure Firewall migration tool analyzes all ASA objects and handles their migration in one
of the following ways:

• Each ASA object has a unique name and configuration—The Secure Firewall migration tool migrates
the objects successfully without changes.

• The name of an ASA object includes one or more special characters that are not supported by the
management center—The Secure Firewall migration tool renames the special characters in the object
name with a "_" character to meet the Management Center object naming criteria.

• AnASA object has the same name and configuration as an existing object in the management center—The
Secure Firewall migration tool reuses the Secure Firewall Management Center object for the Secure
Firewall Threat Defense configuration and does not migrate the ASA object.

• An ASA object has the same name but a different configuration than an existing object in Secure Firewall
Management Center—The Secure Firewall migration tool reports object conflict and allows you to resolve
the conflict by adding a unique suffix to the name of the ASA object for migration purposes.

• Multiple ASA objects have the same name but in different cases—The Secure Firewall migration tool
renames such objects to meet the Secure Firewall Threat Defense object naming criteria.
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The Secure Firewall migration tool analyzes both name and configuration of all objects and object groups.
However, XML profiles in remote-access VPN configurations are analyzed only using the name.

Important

The Secure Firewall migration tool supports discontiguous network mask (Wildcard mask) objects migration
if the destination Firewall Management Center is 7.1 or later.

Note

ASA example:
object network wildcard2
subnet 2.0.0.2 255.0.0.255

Guidelines and Limitations for ASA WebVPN to ZTA Migration

Before attempting an ASAWebVPN to ZTAmigration, make sureb you read the following points thoroughly:

• The target management center and threat defense device must be running Version 7.4 or later.

• The target threat defense device must be using Snort3 as the detection engine.

• The ASA trustpoint certificates (IdP and pre-authentication) must be manually uploaded to the target
management center before migration.

• The application SSL certificates, along with their private keys, must be uploaded to the target management
center before migration.

• Local, RADIUS, and LDAP authentication methods are not supported.

• You can assign only one ZTA policy to a threat defense device.

Guidelines and Limitations for Threat Defense Devices

As you plan to migrate your ASA configuration to threat defense, consider the following guidelines and
limitations:

• If there are any existing device-specific configurations on the threat defense such as routes, interfaces,
and so on, during the push migration, the Secure Firewall migration tool cleans the device automatically
and overwrites from the ASA configuration.

To prevent any undesirable loss of device (target threat defense) configuration
data, we recommend you to manually clean the device before migration.

Note

During migration, the Secure Firewall migration tool resets the interface configuration. If you use these
interfaces in policies, the Secure Firewall migration tool cannot reset them and hence the migration fails.

• The Secure Firewall migration tool can create subinterfaces on the native instance of the threat defense
device based on the ASA configuration. Manually create interfaces and port channel interfaces on the
target threat defense device before starting migration. For example, if your ASA configuration is assigned
with the following interfaces and port channels, you must create them on the target threat defense device
before the migration:
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• Five physical interfaces

• Five port channels

• Two management-only interfaces

For container instances of threat defense devices, subinterfaces are not created
by the Secure Firewall migration tool, only interface mapping is allowed.

Note

• The Secure Firewall migration tool can create subinterfaces and Bridge-Group Virtual Interfaces
(transparent mode) on the native instance of the threat defense device that is based on the ASA
configuration. Manually create interfaces and port channel interfaces on the target threat defense device
before startingmigration. For example, if your ASA configuration is assigned with the following interfaces
and port channels, you must create them on the target threat defense device before the migration:

• Five physical interfaces

• Five port channels

• Two management-only interfaces

For container instances of threat defense devices, subinterfaces are not created
by the Secure Firewall migration tool, only interface mapping is allowed.

Note

Supported Platforms for Migration
The followingASA and threat defense platforms are supported for migration with the Secure Firewall migration
tool. For more information about the supported threat defense platforms, see Cisco Secure Firewall
Compatibility Guide.

The Secure Firewall migration tool supports migration of standalone ASA devices to a standalone threat
defense device only.

Note

Supported Source ASA Platforms

You can use the Secure Firewall migration tool to migrate the configuration from the following single or
multi-context ASA platforms:

• ASA 5510

• ASA 5520

• ASA 5540

• ASA 5550
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• ASA 5580

• ASA 5506

• ASA 5506W-X

• ASA 5506H-X

• ASA 5508-X

• ASA 5512-X

• ASA 5515-X

• ASA 5516-X

• ASA 5525-X

• ASA 5545-X

• ASA 5555-X

• ASA 5585-Xwith ASA only (the Secure Firewall migration tool does not migrate the configuration from
the) ASA FirePOWER module

• Firepower 1000 Series

• Firepower 2100 Series

• Secure Firewall 3100 Series

• Firepower 4100 Series

• Secure Firewall 4200 Series

• Firepower 9300 Series

• SM-24

• SM-36

• SM-40

• SM-44

• SM-48

• SM-56

• ASA Virtual on VMware, deployed using VMware ESXi, VMware vSphere Web Client, or vSphere
standalone client

Supported Target Threat Defense Platforms

You can use the Secure Firewall migration tool to migrate a source ASA configuration to the following
standalone or container instance of the threat defense platforms:

• ASA 5506

• ASA 5506W-X
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• ASA 5506H-X

• ASA 5508-X

• ASA 5512-X

• ASA 5515-X

• ASA 5516-X

• ASA 5525-X

• ASA 5545-X

• ASA 5555-X

• Firepower 1000 Series

• Firepower 2100 Series

• Secure Firewall 3100 Series

• Firepower 4100 Series

• Secure Firewall 4200 Series

• Firepower 9300 Series that includes:

• SM-24

• SM-36

• SM-40

• SM-44

• SM-48

• SM-56

• Threat Defense on VMware, deployed using VMware ESXi, VMware vSphere Web Client, or vSphere
standalone client

• Threat Defense Virtual on Microsoft Azure Cloud or AWS Cloud

• For pre-requisites and pre-staging of threat defense virtual in Azure, see
Getting Started with Secure Firewall Threat Defense Virtual and Azure.

• For pre-requisites and pre-staging of threat defense virtual in AWS Cloud,
see Threat Defense Virtual Prerequisites.

Note

For each of these environments, once pre-staged as per the requirements, the Secure Firewall migration
tool requires network connectivity to connect to the management center in Microsoft Azure or AWS
Cloud, and then migrate the configuration to the management center in the Cloud.
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The pre-requisites of pre-staging the management center or threat defense virtual
is required to be completed before using the Secure Firewall migration tool, to
have a successful migration.

Note

The Secure Firewall migration tool requires network connectivity to any devices
hosted in the cloud to either extract the source configuration (ASALive Connect)
or migrate the manually uploaded configuration to the management center in the
cloud. Hence, as a pre-requisite, IP network connectivity is required to be
pre-staged before using the Secure Firewall migration tool.

Note

Supported Target Management Center for Migration
The Secure Firewall migration tool supports migration to threat defense devices managed by the management
center and cloud-delivered Firewall Management Center.

Management Center

Themanagement center is a powerful, web-based, multi-device manager that runs on its own server hardware,
or as a virtual device on a hypervisor. You can use both On-Prem and Virtual management center as a target
management center for migration.

The management center should meet the following guidelines for migration:

• The Management Center software version that is supported for migration, as described in Supported
Software Versions for Migration, on page 30.

• You have obtained and installed smart licenses for threat defense that include all features that you plan
to migrate from the ASA interface, as described in the following:

• The Getting Started section of Cisco Smart Accounts on Cisco.com.

• Register the Firewall Management Center with the Cisco Smart Software Manager.

• Licensing the Firewall System

• You have enabled management center for REST API.

On the management center web interface, navigate to System > Configuration > Rest API
Preferences > Enable Rest API and check the Enable Rest API check box.

You need to have an administrator user role in management center to enable
REST API. For more information on management center user roles, see User
Roles.

Important
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Cloud-Delivered Firewall Management Center

The cloud-delivered Firewall Management Center is a management platform for threat defense devices and
is delivered via Cisco Defense Orchestrator. The cloud-delivered Firewall Management Center offers many
of the same functions as a management center.

You can access the cloud-delivered FirewallManagement Center fromCDO. CDO connects to cloud-delivered
Firewall Management Center through the Secure Device Connector (SDC). For more information about
cloud-delivered Firewall Management Center, see Managing Cisco Secure Firewall Threat Defense Devices
with Cloud-Delivered Firewall Management Center.

The Secure Firewall migration tool supports cloud-delivered Firewall Management Center as a destination
management center for migration. To select the cloud-delivered Firewall Management Center as destination
management center for migration, you need to add the CDO region and generate the API token from CDO
portal.

CDO Regions

CDO is available in three different regions and the regions can be identified with the URL extension.

Table 1: CDO Regions and URL

CDO URLRegion

https://defenseorchestrator.eu/Europe Region

https://defenseorchestrator.com/US Region

https://www.apj.cdo.cisco.com/APJC Region

Supported Software Versions for Migration
The following are the supported Secure Firewall migration tool, ASA and threat defense versions for migration:

Supported Secure Firewall Migration Tool Versions

The versions posted on software.cisco.com are the versions formally supported by our engineering and support
organizations. We strongly recommend you download the latest version of Secure Firewall migration tool
from software.cisco.com.

Supported ASA Versions

The Secure Firewall migration tool supports migration from a device that is running ASA software version
8.4 and later.

Supported Management Center Versions for source ASA Configuration

For ASA, the Secure Firewall migration tool supports migration to a threat defense device managed by a
management center that is running version 6.2.3 or 6.2.3+.

Some features are supported only in the later versions of management center and threat defense.Note
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For optimum migration times, We recommend that you upgrade management center to the suggested release
version provided here: software.cisco.com/downloads.

Note

Supported Threat Defense Versions

The Secure Firewall migration tool recommends migration to a device that is running threat defense version
6.5 and later.

For detailed information about the Cisco Firewall software and hardware compatibility, including operating
system and hosting environment requirements, for threat defense, see the Cisco Firewall Compatibility Guide.

Related Documentation
This section summarizes the ASA to threat defense migration related documentation.

• Cisco Secure Firewall ASA to Threat Defense FeatureMapping—Lists the commonly used ASA features
and their equivalent threat defense capabilities. For each ASA feature, the equivalent threat defense
feature with a UI path to configure it in the Secure Firewall Management Center or Cisco Defense
Orchestrator (CDO) cloud-delivered Firewall Management Center is listed.

• Migrating Certificates from ASA to Firepower Threat Defense—Describes the procedure to migrate
Identity (ID) and Certificate Authority (CA) Certificates from Cisco ASA to a Secure Firewall Threat
Defense device.

• Migrating ASA to Firepower Threat Defense Site-to-Site VPNUsing IKEv1with Certificates—Describes
the procedure to migrate site-to-site IKEv1 VPN tunnels, using certificates (rsa-sig) as a method of
authentication, from the existing Cisco ASA to threat defense, managed by management center.

• Migrating ASA to Firepower Threat Defense Site-to-Site VPNUsing IKEv2with Certificates—Describes
the procedure to migrate site-to-site IKEv2 VPN tunnels, using certificates (rsa-sig) as a method of
authentication, from the existing ASA to threat defense, managed by management center.

• Migrating ASA to Firepower Threat Defense Dynamic Crypto Map Based Site-to-Site Tunnel on
FTD—Describes the procedure to migrate a Dynamic Crypto Map based site-to-site VPN tunnels (with
IKEv1 or IKEv2), using pre-shared key and certificate as a method of authentication, from the existing
ASA to threat defense, managed by management center.

• Migrating ASA to Firepower Threat Defense Site-to-Site VPN Using IKEv1 with Pre-Shared Key
Authentication—Describes the procedure to migrate Site-to-Site IKEv1 VPN tunnels, using pre-shared
key (PSK) as a method of authentication, from the existing ASA to threat defense, managed by
management center.

• Migrating ASA to Firepower Threat Defense Site-to-Site VPN Using IKEv2 with Pre-Shared Key
Authentication—Describes the procedure to migrate site-to-site IKEv2 VPN tunnels, using pre-shared
key (PSK) as a method of authentication, from the existing ASA to threat defense, managed by
management center.

• Migrating ASA to Firepower Threat Defense Platform Settings—Describes the steps to migrate the
platform setting configuration of ASA to threat defense devices.

• Cisco ASA FirePOWER Module Quick Start Guide—Describes how the ASA FirePOWER Module
Works with the ASA.
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C H A P T E R 2
ASA to Threat Defense Migration Workflow

• End-to-End Procedure, on page 33
• Prerequisites for Migration, on page 35
• Run the Migration, on page 38
• Uninstall the Secure Firewall Migration Tool, on page 74
• Sample Migration: ASA to Threat Defense 2100 , on page 74

End-to-End Procedure
The following flowchart illustrates the workflow for migrating an ASA to threat defense using the Secure
Firewall migration tool.

StepsWorkspace

Download the latest version of Secure Firewall migration tool fromCisco.com.
For detailed steps, see Download the Secure Firewall Migration Tool from
Cisco.com.

Local Machine
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StepsWorkspace

(Optional) Obtain the ASA configuration file: To obtain the ASA config file
from ASA CLI, see Obtain the ASA Configuration File. If you intend to
connect the ASA from Secure Firewall migration tool, skip to step 3.

ASA CLI

(Optional) Export PKI certificates from ASA CLI: This step is required only
if you are planning to migrate site-to site VPN, RA VPN, or WebVPN
configurations from ASA to threat defense. To export the PKI certificates
from ASA CLI, see Export PKI Certificate from ASA and Import into
Management Center. If you are not planning to migrate site-to-site VPN, RA
VPN, or WebVPN configurations, skip to step 7.

ASA CLI

(Optional) Export AnyConnect packages and profiles from ASA CLI: This
step is required only if you are planning to migrate RA VPN features from
ASA to threat defense. To export AnyConnect packages and profiles from
ASA CLI, see Retrieve AnyConnect Packages and Profiles. If you are not
planning to migrate site-to-site VPN and RA VPN, skip to step 7.

ASA CLI

(Optional) Import the PKI certificates and AnyConnect packages to
management center: To import the PKI certificates to management center,
see Export PKI Certificate from ASA and Import into Management Center
and Retrieve AnyConnect Packages and Profiles.

Management Center

Launch the Secure Firewall migration tool on your local machine, see Launch
the Secure Firewall Migration Tool.

Local Machine

(Optional) Upload the ASA config file obtained from ASA CLI, see Upload
the ASA Configuration File. If you are planning to connect to live ASA, skip
to step 8.

Secure Firewall
Migration Tool

You can connect to live ASA directly from the Secure Firewall migration
tool. For more information, see Connect to the ASA from the Secure Firewall
Migration Tool.

Secure Firewall
Migration Tool

During this step, you can specify the destination parameters for the migration.
For detailed steps, see Specify Destination Parameters for the Secure Firewall
Migration Tool.

Secure Firewall
Migration Tool

(Optional) This step is optional and only required if you have selected
cloud-delivered Firewall Management Center as destination management
center. For detailed steps, see Specify Destination Parameters for the Secure
Firewall Migration Tool.

CDO

Navigate to where you downloaded the pre migration report and review the
report. For detailed steps, see Review the Pre-Migration Report.

Secure Firewall
Migration Tool

The Secure Firewall migration tool allows you tomap the ASA configuration
with threat defense interfaces. For detailed steps, seeMapASAConfigurations
with Threat Defense Interfaces.

Secure Firewall
Migration Tool
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StepsWorkspace

To ensure that the ASA configuration is migrated correctly, map the ASA
interfaces to the appropriate threat defense interface objects, security zones
and interface groups. For detailed steps, see Map ASA Interfaces to Security
Zones, Interface Groups, and VRFs.

Secure Firewall
Migration Tool

Optimize and review the configuration carefully and validate that it is correct
andmatches how you want to configure the threat defense device. For detailed
steps, see Optimize, Review and Validate the Configuration.

Secure Firewall
Migration Tool

This step in the migration process sends the migrated configuration to
management center and allows you to download the post-migration report.
For detailed steps, see Push the Migrated Configuration to Management
Center.

Secure Firewall
Migration Tool

Navigate to where you downloaded the post migration report and review the
report. For detailed steps, see Push theMigrated Configuration toManagement
Center.

Local Machine

Deploy the migrated configuration from the management center to threat
defense. For detailed steps, see Review the Post-Migration Report and
Complete the Migration.

Management Center

Prerequisites for Migration
Before you migrate your ASA configuration, execute the following activities:

Download the Secure Firewall Migration Tool from Cisco.com

Before you begin

You must have a Windows 10 64-bit or macOS version 10.13 or higher machine with an internet connectivity
to Cisco.com.

Procedure

Step 1 On your computer, create a folder for the Secure Firewall migration tool.

We recommend that you do not store any other files in this folder. When you launch the Secure Firewall
migration tool, it places the logs, resources, and all other files in this folder.

Whenever you download the latest version of the Secure Firewall migration tool, ensure, you create
a new folder and not use the existing folder.

Note

Step 2 Browse to https://software.cisco.com/download/home/286306503/type and click Firewall Migration Tool.

The above link takes you to the Secure Firewall migration tool under Firewall NGFW Virtual. You can also
download the Secure Firewall migration tool from the threat defense device download areas.
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Step 3 Download the most recent version of the Secure Firewall migration tool into the folder that you created.

Download the appropriate executable of the Secure Firewall migration tool forWindows or macOSmachines.

What to do next

Obtain the ASA Configuration File

Obtain the ASA Configuration File
You can use one of the following methods to obtain an ASA configuration file:

• Export the ASA Configuration File, on page 36

• Connect to the ASA from the Secure Firewall Migration Tool, on page 41

Export the ASA Configuration File
This task is required only if you want to manually upload an ASA configuration file. If you want to connect
to an ASA from the Secure Firewall migration tool, skip to Connect to the ASA from the Secure Firewall
Migration Tool, on page 41.

Do not hand code or make changes to the ASA configuration after you export the file. These changes will not
be migrated to threat defense, and they create errors in the migration or cause the migration to fail. For example,
opening and saving the configuration file in terminal can add white space or blank lines that the Secure Firewall
migration tool cannot parse.

Ensure that the exported ASA configuration file does not contain the "--More--" keyword as text, as this can
cause the migration to fail.

Note

Procedure

Step 1 Use the show running-config command for the ASA device or context that you are migrating and copy the
configuration from there. See View the Running Configuration.

Alternately, use Adaptive Security Device Manager (ASDM) for the ASA device or context that you want to
migrate and choose File > Show Running Configuration in New Window to obtain the configuration file.

For a multi context ASA, you can use the show tech-support command to obtain the configuration
for all the contexts in a single file.

Note

Step 2 Save the configuration as either .cfg or .txt.

You cannot upload the ASA configuration to the Secure Firewall migration tool if it has a different extension.

Step 3 Transfer the ASA configuration file to your computer where you downloaded the Secure Firewall migration
tool.
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Export PKI Certificate from ASA and Import into Management Center

Before you begin

The Secure Firewall migration tool supports migration of certificate-based VPN into the management center.

ASA uses the trustpoint model for storing certificates in the configuration. A trustpoint is a container in which
certificates are stored. ASA trustpoint can store up to two certificates.

The ASA trustpoint or certificates in the ASA configuration file contains hash values. Hence, you cannot
directly import them into a management center.

In the destination management center, migrate the ASA trustpoint or the VPN certificates manually as PKI
objects as part of the pre-migration activity.

Procedure

Step 1 Use the following command to export the PKI certificate through the CLI from the source ASA config with
the keys to a PKCS12 file:
ASA(config)#crypto ca export <trust-point-name> pkcs12 <passphrase>

Step 2 Import the PKI certificate into a management center (Object Management PKI Objects).

For more information, see PKI Objects in the Firepower Management Center Configuration Guide.

The manually created PKI objects can now be used in the Secure Firewall migration tool under theTrustpoint
section in Remote Access VPN tab in the Optimize, Review, and Validate page.

Retrieve AnyConnect Packages and Profiles
AnyConnect profiles are optional and can be uploaded through the management center or Secure Firewall
migration tool.

Before you begin

• Remote Access VPN on the management center requires at least one AnyConnect package.

• If the configuration consists of Hostscan and External Browser package, you must upload these packages.

• All packages must be added to the management center as part of the pre-migration activity.

• Dap.xml and Data.xml must be added through the Secure Firewall migration tool.

Procedure

Step 1 Use the following command to copy the required package from the source ASA to an FTP or TFTP server:
Copy <source file location:/source file name> <destination>
ASA# copy disk0:/anyconnect-win-4.10.02086-webdeploy-k9.pkg tftp://1.1.1.1 <----- Example
of copying Anyconnect Package.
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ASA# copy disk0:/ external-sso- 4.10.04071-webdeploy-k9.zip tftp://1.1.1.1 <----- Example
of copying External Browser Package.
ASA# copy disk0:/ hostscan_4.10.04071-k9.pkg tftp://1.1.1.1 <----- Example of copying
Hostscan Package.
ASA# copy disk0:/ dap.xml tftp://1.1.1.1. <----- Example of copying Dap.xml
ASA# copy disk0:/ sdesktop/data.xml tftp://1.1.1.1 <----- Example of copying Data.xml
ASA# copy disk0:/ VPN_Profile.xml tftp://1.1.1.1 <----- Example of copying Anyconnect
Profile.

Step 2 Import the downloaded packages to management center (Object Management > VPN > AnyConnect File).

a. Dap.xml and Data.xml must be uploaded to the management center from the Secure Firewall migration
tool in the Review and Validate > Remote Access VPN > AnyConnect File section.

b. AnyConnect profiles can be uploaded directly to the management center or through the Secure Firewall
migration tool in the Review and Validate > Remote Access VPN > AnyConnect File section.

The manually uploaded files can now be used in the Secure Firewall migration tool.

Run the Migration

Launch the Secure Firewall Migration Tool
This task is applicable only if you are using the desktop version of the Secure Firewall migration tool. If you
are using the cloud version of the migration tool hosted on CDO, skip to Upload the ASA Configuration File,
on page 41 .

When you launch the Secure Firewall migration tool a console opens in a separate window. As you go through
the migration, the console displays the progress of the current step in the Secure Firewall migration tool. If
you do not see the console on your screen, it is most likely to be behind the Secure Firewall migration tool.

Note

Before you begin

• Download the Secure Firewall Migration Tool from Cisco.com

• Review and verify the requirements in the Supported Target Management Center for Migration, on page
29 section.

• Ensure that your computer has a recent version of the Google Chrome browser to run the Secure Firewall
migration tool. For information on how to set Google Chrome as your default browser, see Set Chrome
as your default web browser.

• If you are planning to migrate a large configuration file, configure sleep settings so the system doesn’t
go to sleep during a migration push.

Procedure

Step 1 On your computer, navigate to the folder where you downloaded the Secure Firewall migration tool.
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Step 2 Do one of the following:

• On your Windows machine, double-click the Secure Firewall migration tool executable to launch it in
a Google Chrome browser.

If prompted, click Yes to allow the Secure Firewall migration tool to make changes to your system.

The Secure Firewall migration tool creates and stores all related files in the folder where it resides,
including the log and resources folders.

• On your Mac move, the Secure Firewall migration tool *.command file to the desired folder, launch the
Terminal application, browse to the folder where the Secure Firewall migration tool is installed and run
the following commands:

# chmod 750 Firewall_Migration_Tool-version_number.command

# ./Firewall_Migration_Tool-version_number.command

The Secure Firewall migration tool creates and stores all related files in the folder where it resides,
including the log and resources folders.

When you try to open the Secure Firewall migration tool, you get a warning dialog because the
Secure Firewall migration tool is not registered with Apple by an identified developer. For
information on opening an application from an unidentified developer, see Open an app from an
unidentified developer.

Tip

Use MAC terminal zip method.Note

Step 3 On the End User License Agreement page, click I agree to share data with Cisco Success Network if you
want to share telemetry information with Cisco, else click I'll do later.

When you agree to send statistics to Cisco Success Network, you are prompted to log in using your Cisco.com
account. Local credentials are used to log in to the Secure Firewall migration tool if you choose not to send
statistics to Cisco Success Network.

Step 4 On the Secure Firewall migration tool's login page, do one of the following:

• To share statistics with Cisco Success Network, click theLogin with CCO link to log in to your Cisco.com
account using your single sign-on credentials. If you do not have a Cisco.com account, create it on the
Cisco.com login page.

Proceed to step 8, if you have used your Cisco.com account to log in.

• If you have deployed your firewall in an air-gapped network that does not have internet access, contact
Cisco TAC to receive a build that works with administrator credentials. Note that this build does not
send usage statistics to Cisco, and TAC can provide you the credentials.

Step 5 On the Reset Password page, enter the old password, your new password, and confirm the new password.

The new password must have 8 characters or more and must include upper and lowercase letters, numbers,
and special characters.

Step 6 Click Reset.
Step 7 Log in with the new password.

If you have forgotten the password, delete all the existing data from the <migration_tool_folder> and
reinstall the Secure Firewall migration tool.

Note
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Step 8 Review the pre-migration checklist and make sure you have completed all the items listed.

If you have not completed one or more of the items in the checklist, do not continue until you have done so.

Step 9 Click New Migration.
Step 10 On the Software Update Check screen, if you are not sure you are running the most recent version of the

Secure Firewall migration tool, click the link to verify the version on Cisco.com.
Step 11 Click Proceed.

What to do next

You can proceed to the following step:

• If you have exported ASA configuration to your computer, proceed to Upload the ASA Configuration
File.

• If you want to extract information from an ASA using the Secure Firewall migration tool, proceed to
Connect to the ASA from the Secure Firewall Migration Tool, on page 41

Using the Demo Mode in the Secure Firewall Migration Tool
When you launch the Secure Firewall Migration tool and are on the Select Source Configuration page, you
can choose to start performing a migration using Start Migration or enter the Demo Mode.

The demo mode provides an opportunity to perform a demo migration using dummy devices and visualize
how an actual migration flow would look like. The migration tool triggers the demo mode based on the
selection you make in the Source Firewall Vendor drop-down; you can also upload a configuration file or
connect to a live device and continue with the migration. You can proceed performing the demo migration
by selecting demo source and target devices such as demo FMC and demo FTD devices.

ChoosingDemo Mode erases existing migration workflows, if any. If you use the demomode while you have
an active migration in Resume Migration, your active migration is lost and needs to be restarted from first,
after you use the demo mode.

Caution

You can also download and verify the pre-migration report, map interfaces, map security zones, map interface
groups, and perform all other actions like you would in an actual migration workflow. However, you can only
perform a demo migration up to validation of the configurations. You cannot push the configurations to the
demo target devices you selected because this is only a demo mode. You can verify the validation status and
the summary and click Exit Demo Mode to go the Select Source Configuration page again to start your
actual migration.

The demo mode lets you leverage the whole feature set of the Secure Firewall Migration Tool, except pushing
of configurations, and do a trial run of the end-to-end migration procedure before performing your actual
migration.

Note
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Upload the ASA Configuration File

Before you begin

Export the configuration file as .cfg or .txt from the source ASA device.

Do not upload a hand-coded or manually altered configuration file. Text editors add blank lines and other
issues to the file that can cause the migration to fail.

Note

Procedure

Step 1 On the Extract ASA Information page, in the Manual Upload section, click Upload to upload an ASA
configuration file.

Step 2 Browse to where the ASA configuration file is located and click Open.

The Secure Firewall migration tool uploads the configuration file. For large configuration files, this step takes
a longer time. The console provides a line by line log view of the progress, including the ASA configuration
line that is being parsed. If you do not see the console, you can find it in a separate window behind the Secure
Firewall migration tool. The Context Selection section identifies if the uploaded configuration corresponds
to the multi-context ASA.

Step 3 Review the Context Selection section and select the ASA context that you want to migrate.

What to do next

Specify Destination Parameters for the Secure Firewall Migration Tool, on page 44

Connect to the ASA from the Secure Firewall Migration Tool
The Secure Firewall migration tool can connect to an ASA device that you want to migrate and extract the
required configuration information.

Before you begin

• Download and launch the Secure Firewall migration tool.

• For single context ASA, obtain the management IP address, administrator credentials, and the enable
password.

• For multi-context mode ASA, obtain the IP address of the admin context, administrator credentials, and
the enable password.

If ASA is not configured with Enable Password, you can leave the field blank
on the Secure Firewall migration tool.

Note
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Procedure

Step 1 On the Extract ASA Information screen, in the Connect to ASA section, click Connect to connect to the
ASA device that you want to migrate.

Step 2 On the ASA Login screen, enter the following information:

a. In theASA IP Address/Hostname field, enter the management IP address or hostname (for single context
ASA) or IP address of the admin context or hostname (for a multi-context ASA).

b. In the Username, Password, and Enable Password fields enter the appropriate administrator login
credentials.

If ASA is not configured with an Enable password, you can leave the field blank on the Secure
Firewall migration tool.

Note

c. Click Login.

When the Secure Firewall migration tool connects to the ASA, it displays a successfully connected to the
ASA message. For a multi-context ASA, the Secure Firewall migration tool identifies and lists the contexts.

Step 3 Select the ASA context that you want to migrate from the Context drop-down list.
Step 4 (Optional) Select Collect Hitcounts.

When checked, this tool computes the number of times an ASA rule was used and the last time the rule was
used since ASA uptime or last ASA restart and displays this information on the Review and Validate page.
This allows you to evaluate the efficacy and relevance of the rule before migration.

Step 5 Click Start Extraction.

The Secure Firewall migration tool connects to the ASA and starts extracting configuration information.When
the extraction completes successfully, the Context Selection section identifies if the uploaded configuration
corresponds to a single-context or multi-context ASA.

What to do next

Specify Destination Parameters for the Secure Firewall Migration Tool, on page 44

Select the ASA Security Context

Before you begin

You can partition a single ASA device into multiple virtual devices, and these partitions are known as security
contexts. Each security context acts as an independent device, with its own security policies, interfaces, and
administrators. Multiple contexts are similar to having multiple standalone devices, while you actually have
only one device. To know more about security contexts, see Common Uses for Security Contexts in the Cisco
ASA Series General Operations CLI Configuration Guide.

This task procedure is applicable to you if you have configured two or more security contexts on your Cisco
Secure Firewall ASA. When you upload your ASA configuration, the Secure Firewall migration tool detects
security contexts on your device, parses all the configuration information pertaining to the contexts, and
displays them on the Context Selection page.
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Procedure

Step 1 Upload your ASA configuration file; if your configuration file contains contexts, the migration tool displays
the names of all the security contexts.

Step 2 (Optional) Tomigrate configurations from one of your contexts, click theContext Migration (One at a time)
radio button and choose a context to proceed with migration.

Step 3 (Optional) To merge configurations from multiple contexts into a single instance and migrate them, click the
Merge Multi-Context to Single Instance radio button. When you opt for multicontext merging, you can see
context information such as the number of configuration lines, ACLs, objects, routes including static routes,
PBR, and ECMP, and interfaces. Note that merging multiple contexts into a single instance is supported for
both transparent and routed firewall-mode contexts. However, ensure that you select contexts of the same
type to be merged; you cannot merge a transparent mode context with a routed-mode context. The system
and admin contexts are not supported, and the migration tool does not detect them.

Make sure that you read these prerequisites before attempting to merge multiple contexts:

• If you have port channels configured on your ASA, ensure they are configured in your target
threat defense device also.

• If two interfaces have the same VLAN ID and subinterface ID, the migration tool automatically
adds new VLAN and subinterface IDs to a new interface. Information about these IDs is part of
the premigration report. Ensure that you configure these new interfaces created by the migration
tool to the trunk port objects of the corresponding devices. This is because threat defense devices
do not allow two interfaces with the same VLAN and subinterface IDs.

• The AS path objects must be unique across all the contexts that are being migrated. Duplicates
are not migrated.

Note

When merging multiple contexts, if two or more of the contexts that you have chosen to merge have
VPN configured, the migration tool prompts you to select one of the contexts with VPN configuration.
Only the VPN configuration in the selected context is migrated and those from the other contexts are
ignored. However, note that all the other configurations, such as objects, extended ACLs, NAT rules,
and unreferenced VPN objects in the unselected contexts are still migrated.

Note

Step 4 Click Start Parsing. Once you select a context and start to parse, the migration tool merges the configurations
from all the contexts, parses them, and displays the Parsed Summary. If you are performing a merged-context
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migration, note that the number of contexts you selected to migrate is the same as the number of VRFs in the
parsed summary. However, if you have a context with VPN configuration, the parsed summary displays one
VRF less, because the VRF that has the VPN configuration gets pushed to the global router directly.

If you have clicked Start Parsing and you wish to select a different context, you cannot go back and
select a different context. You can clickBack and start from uploading your configuration file, selecting
a different context this time.

Note

Step 5 Review the summary of the elements in the uploaded configuration file that the Secure Firewall migration
tool detected and parsed.

Step 6 Click Next to select the target parameters.

Specify Destination Parameters for the Secure Firewall Migration Tool

Before you begin

If you are using the cloud version of the migration tool hosted on CDO, skip to Step 3.

• Obtain the IP address for the management center for On-Prem Firewall Management Center.

• From Secure FirewallMigration Tool 3.0 onwards, you can select betweenOn-Prem FirewallManagement
Center or Cloud-delivered Firewall Management Center.

• For Cloud-delivered Firewall Management Center, region and API token have to be provided. For more
information, see Supported Target Management Center for Migration.

• Create a dedicated account for the Secure Firewall migration tool in the management center with sufficient
privileges to access the REST API, as described in User Accounts for Management Access.

• (Optional) If you want to migrate device-specific configurations like interfaces and routes, add the target
threat defense to the management center. See Adding Devices to the Firewall Management Center

• If it requires you to apply IPS or file policy to ACL in the Review and Validate page, we highly
recommend you create a policy on the management center before migration. Use the same policy, as the
Secure Firewall migration tool fetches the policy from the connected management center. Creating a
new policy and assigning it to multiple access control lists may degrade the performance and may also
result in a push failure.

Procedure

Step 1 On the Select Target screen, in the Firewall Management section, do the following: you can choose to
migrate to an On-Prem Firewall Management Center or Cloud-delivered Firewall Management Center:

• For migrating to an On-Prem Firewall Management Center, do the following:

a) Click the On-Prem FMC radio button.
b) Enter the IP address or Fully-Qualified Domain Name (FQDN) for the management center.
c) In the Domain drop-down list, select the domain to which you are migrating.
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If you want to migrate to a threat defense device, you can only migrate to the threat defense devices
available in the selected domain.

d) Click Connect and proceed to Step 2.

• For migrating to a Cloud-delivered Firewall Management Center, do the following:

a) Click the Cloud-delivered FMC radio button.
b) Choose the region and paste the CDO API token. For generating the API token. from CDO, follow the

below steps:

1. Log in to CDO portal.

2. Navigate to Settings > General Settings and copy the API Token.

c) Click Connect and proceed to Step 2.

Step 2 In the Firewall Management Center Login dialog box, enter the username and password of the dedicated
account for the Secure Firewall migration tool, and click Login.

The Secure Firewall migration tool logs in to the management center and retrieves a list of threat defense
devices that are managed by that management center. You can view the progress of this step in the console.

Step 3 Click Proceed.

In the Choose Threat Defense section, you can either select a threat defense device that you want to migrate
to, or if you do not have a threat defense device, you can migrate the shared policies (Access Control Lists,
NAT, and Objects) of the ASA configuration to the management center.

Step 4 In the Choose FTD section, do one of the following:

• Click the Select FTD DeviceSelect FTD Device (Includes FTD - Standalone/HA Pair) drop-down
list and check the device where you want to migrate the ASA configuration.

This list includes both standalone threat defense devices and devices that are part of a high
availability (HA) pair on the target management center.

Note

The devices in the selected management center domain are listed by IP Address, Name, Device Model,
and Mode (routed or transparent).

At minimum, the native threat defense device you choose must have the same number of physical
or port channel interfaces as the ASA configuration that you are migrating. At minimum, the
container instance of the threat defense device must have the same number of physical or port
channel interfaces and subinterfaces. You must configure the device with the same firewall mode
as the ASA configuration. However, these interfaces do not have to have the same names on both
devices.

Note

Only when the supported target threat defense platform is Firewall 1010 with management center
version 6.5 or later.6.5, FDM 5505 migration support is applicable for shared policies and not
for device specific policies. When you proceed without threat defense, the Secure Firewall
migration tool will not push any configurations or the policies to the threat defense. Thus, interfaces
and routes, and site-to-site VPN which are threat defense device-specific configurations will not
be migrated. However, all the other supported configurations (shared policies and objects) such
as NAT, ACLs, and port objects will be migrated. Remote Access VPN is a shared policy and
can be migrated even without threat defense.

Note
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Table 2: ASA Firewall Features and Supported Management Center or Threat Defense Versions

Supported Management Center or Threat Defense
Version

Firewall Features

6.7 or laterASA with remote deployment

6.6 or laterCrypto Map Site-to-Site VPN

6.7 or laterVirtual Tunnel Interface (VTI) and Route-based
(VTI)

7.1 or laterDynamic-Route Objects and BGP

• Management Center 7.2 or later

• Threat Defense 7.0 or later.

Remote Access VPN

• Management Center 7.2 or later

• Threat Defense 7.0 or later.

EIGRP

• Management Center 7.3 or later

• Threat Defense 7.3 or later.

PBR

• Management Center 7.1 or later

• Threat Defense 6.5 or later.

ECMP

• Management Center 7.4 or later

• Threat Defense 7.4 or later

WebVPN

• Management Center 7.4 or later

• Threat Defense 7.4 or later

SNMP

• Management Center 7.4 or later

• Threat Defense 7.4 or later

DHCP Relay, Server, and DDNS

To migrate Site-to-Site VPN, VTI, and Route-based (VTI) interfaces, threat defense must be
configured on management center.

Note

• For ASA 5505, the device-specific configs (Interface and routes) and shared policies (NAT, ACLs, and
Objects) can be migrated only when the supported target threat defense platform is Firewall 1010 with
management center version 6.5 or later.
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Note • If the target threat defense is not FPR-1010 or the target management center is earlier than
6.5, ASA 5505 migration support is applicable for shared policies only. Device specifics
will not be migrated.

• You can select only FPR-1010 in the Select Device drop-down list as the source config is
ASA 5505.

• ASA-SMmigration support is for shared policies only. Device specifics will not be migrated.

• Click Proceed without FTD to migrate the configuration to the management center.

When you proceed without threat defense, the Secure Firewall migration tool will not push any
configurations or the policies to threat defense. Thus, interfaces and routes, and site-to-site VPN which
are threat defense device-specific configurations will not be migrated and need to be manually configured
on management center. However, all the other supported configurations (shared policies and objects)
such as NAT, ACLs, and port objects will be migrated. Remote Access VPN is a shared policy and can
be migrated even without threat defense.

• This option displays only if the source ASA device is in an HA pair.

Click Proceed with FTD HA Pair Configuration to select active and standby threat defense devices
for your HA pair. When you select the active device, ensure that there is an identical device on the target
management center for FMT to be able to show up the idential device as the standby device option and
the HA pair creation to be successful.

You cannot proceed to the further steps of migration if there is no identical device on the target
management center to be selected as the standby device or if you do not select a standby threat
defense device.

Note

Click Setup FTD HA Pair and configure the following on the Configure Target FTDs in High
Availability Pair window:

a. Specify a name for the HA pair in the HA Pair Name filed.
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b. Under High Availability Link, choose an Interface which has enough bandwidth to reserve when
failover communications need to happen.

The Interface drop-down lists only the interfaces which do not have a logical name and are
not part of any security zones.

Note

c. Specify a Logical Name for the interface.

d. Specify a Primary IP address for the high availability link on the active device unit. Ensure that the
IP address is on an unused subnet.

e. Specify a Secondary IP address for the high availability link on the standby device unit. Ensure that
the secondary IP address is on the same subnet as the primary IP address.

f. Specify a Subnet Mask that applies to both the primary and secondary IP addresses.

g. Under State Link, choose Same as LAN Failover Link or a different Interface. Selecting the Same
as LAN Failover Link populates the data from the failover link that you just configured.

h. Check the Enabled checkbox under IPsec Encryption to enable encryption between the failover
links and choose a Key Generation method.

i. Click Add to start setting up the HA pair.

Note that the Notifications Center icon keeps blinking until the creation of HA pair is in progress. In
cases where the creation of HA pair fails for some reason, FMT notifies you by showing a Blocked error
message. In such cases, because the migration tool attempted to create the HA pair and failed, the
management center will have the HA pair created but not successful.

Log in to the management center and break the HAmanually and selectClick Here in the error message
in the migration tool to start to configure the HA pair again. For more information on how to break an
HA pair, see:

• Break a High Availability Pair if the target management center is On-Prem Firewall Management
Center

• Break a High Availability Pair if the target management center is cloud-delivered Firewall
Management Center

The values entered or populated as part of the other migration steps are retained even if the HA
setup fails and is to be re-configured.

Note

Step 5 Click Proceed.

Depending on the destination that you are migrating to, the Secure Firewall migration tool allows you to select
the features that you want to migrate.

Step 6 Click the Select Features section to review and select the features that you want to migrate to the destination.

• If you are migrating to a destination threat defense device, the Secure Firewall migration tool automatically
selects the features available for migration from the ASA configuration in the Device Configuration
and Shared Configuration sections. You can further modify the default selection, according to your
requirements.

• If you are migrating to a management center, the Secure Firewall migration tool automatically selects
the features available for migration from the ASA configuration in the Device Configuration, Shared
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Configuration, and Optimization sections. You can further modify the default selection, according to
your requirements.

• The Secure Firewall migration tool supports the following for access control during migration:

• Populate Destination Security Zones—Enables mapping of destination zones for the ACL during
migration.

Route-lookup logic is limited to Static Routes and Connected Routes, whereas PBR, Dynamic
Routes, and NAT are not considered. Interface network configuration is used to derive the connected
route information.

Based on the nature of Source and Destination network object-groups, this operation may result in
rule explosion.

• Migrate Tunneled rules as Prefilter—Mapping of ASA encapsulated tunnel protocol rule to Prefilter
tunnel rules has the following advantages:

• Tailor Deep Inspection—For encapsulated traffic and to improve performance with fastpathing.

• Improve Performance—You can fastpath or block any other connections that benefit from
early handling.

The Secure Firewall migration tool identifies the encapsulated tunnel traffic rules in source
configuration and migrates them as Prefilter tunnel rules. You can verify the migrated tunnel rule
under the Prefilter policy. The Prefilter policy is associated with the migrated access control policy
on management center.

The protocols which are migrated as Prefilter tunnel rules are following:

• GRE (47)

• IPv4 encapsulation (4)

• IPv6 encapsulation (41)

• Teredo Tunneling (UDP:3544)

If you do not opt to select the prefilter option, all the tunneled traffic rules will be migrated
as unsupported rules.

Note

The ACL tunnel rules (GRE and IPnIP) in the ASA configuration are currently migrated as
bidirectional by default. You can now specify the Rule direction for the destination as bidirectional
or unidirectional in the access control state option.

• The Secure Firewall migration tool supports the following interfaces and objects for VPN Tunnel
migration:

• Policy-based (Crypto Map)—If the target management center and threat defense is version 6.6 or
later.

• Route-based (VTI)—If the target management center and threat defense is version 6.7 or later.

• The Secure Firewall migration tool supports migration of Remote Access VPN if the target management
center is 7.2 or later. Remote Access VPN is a shared policy that can be migrated without threat defense.
If migration is selected with threat defense, the threat defense version should be 7.0 or later.

• (Optional) In the Optimization section, select Migrate only referenced objects to migrate only those
objects that are referenced in an access control policy and a NAT policy.
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Note When you select this option, unreferenced objects in the ASA configuration will not be migrated.
This optimizes migration time and cleans out unused objects from the configuration.

• (Optional) In the Optimization section, select Object group search for optimal memory utilization by
access policy on threat defense.

• (Optional) In the Inline Grouping section, the Secure Firewall migration tool allows you to clear the
access rules of the pre-defined network and service object names that start with CSM or DM. If you
uncheck this option, the pre-defined object names will be retained duringmigration. For more information,
see Inline Grouping.

By default, the option of Inline Grouping is enabled.Note

• If you have SNMP and DHCP Server, Relay, and DDNS configurations on your source ASA device,
the corresponding checkboxes are checked by default. Manually uncheck them if you do not want to
migrate these configurations. Note that when DHCP is selected, you can either check Server or both
Relay and DDNS.

• If you have group policies with SSL clientless VPN tunnel protocol configurations and tunnel groups
with group policies that use SAML authentication, the migration tool checks the WebVPN checkbox by
default. Ensure you manually uncheck this if you do not want to migrate these configurations.

Step 7 Click Proceed.
Step 8 In the Rule Conversion/ Process Config section, click Start Conversion to initiate the conversion.
Step 9 Review the summary of the elements that the Secure Firewall migration tool converted.

To check whether your configuration file is successfully uploaded and parsed, download and verify the
Pre-Migration Report before you continue with the migration.

Step 10 Click Download Report and save the Pre-Migration Report.

A copy of the Pre-Migration Report is also saved in the Resources folder in the same location as the
Secure Firewall migration tool.

What to do next

Review the Pre-Migration Report, on page 51

Inline Grouping

Object Grouping by ASDM and CSM Managed ASA

When you enter more than one item (object or inline values) in the source or destination address, or source
or destination service, CSM or ASDM automatically creates an object group. The naming conventions for
these object groups that are used by CSM and ASDM are CSM_INLINE and DM_INLINE respectively while
deploying the configuration on to respective ASA device.

To change the behavior of the object grouping from Tools > Preferences, choose Auto-expand network
and service objects with specified prefix rule table preference.

Note

The following is the configuration snippet extracted using the show run command on ASA managed by
ASDM.
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object network host1
host 10.1.1.100
object network fqdn_obj1
fqdn abc.cisco.com
object-group network DM_INLINE_NETWORK_1
network-object 10.21.44.189 255.255.255.255
network-object 10.21.44.190 255.255.255.255
object-group network DM_INLINE_NETWORK_2
network-object 10.21.44.191 255.255.255.255
network-object object host1
network-object object fqdn_obj1

access-list CSM_DM_ACL extended permit tcp object-group DM_INLINE_NETWORK_1 object-group
DM_INLINE_NETWORK_2

In the above example, access-list CSM_DM_ACL on ASDMUI does not show DM_INLINE group as rule’s
Source and Destination network instead displays contents of DM_INLINE group.

Inline Grouping—ASDM/CSM

The Inline Grouping functionality of the Secure Firewall migration tool allows you to parse show
running-configuration of ASDM or CSMmanaged ASA devices. It provides an option to preserve the same
UI representation of the access-list rules as on ASDM or CSM. If opted out, migrated rules will refer to
DM_INLINE groups as recorded in ASA show running-configuration.

The source ASA configuration file input to the Secure Firewall migration tool would still be show run or
show tech collected from ASA or via live connection to ASA device (SSH). The Secure Firewall migration
tool does not support any other form of configuration files or methods.

Note

The following figures show how the Source and Destination Network fields of ACE or RULE change based
on the enabling or disabling the inline grouping option respectively.

Figure 1: With Inline Grouping—ASDM/CSM Enabled

Figure 2: With Inline Grouping—ASDM/CSM Disabled

Review the Pre-Migration Report
If you havemissed to download the Pre-Migration Reports duringmigration, use the following link to download:

Pre-Migration Report Download Endpoint—http://localhost:8888/api/downloads/pre_migration_summary_
html_format
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You can download the reports only when the Secure Firewall migration tool is running.Note

Procedure

Step 1 Navigate to where you downloaded the Pre-Migration Report.

A copy of the Pre-Migration Report is also saved in the Resources folder in the same location as the
Secure Firewall migration tool.

Step 2 Open the Pre-Migration Report and carefully review its contents to identify any issues that can cause the
migration to fail.

The Pre-Migration Report includes the following information:

• Overall Summary—The method used to extract the ASA configuration information or connecting to a
live ASA configuration.

If connecting to a live ASA, the firewall mode detected on the ASA, and for multiple context mode, the
context you chose for migration.

A summary of the supported ASA configuration elements that can be successfully migrated to threat
defense and specific ASA features selected for migration.

While connecting to a live ASA, the summary includes the hit count information- the number of times
an ASA rule was encountered and its time-stamp information.

• Configuration Lines with Errors—Details of ASA configuration elements that cannot be successfully
migrated because the Secure Firewall migration tool could not parse them. Correct these errors on the
ASA configuration, export a new configuration file, and then upload the new configuration file to the
Secure Firewall migration tool before proceeding.

• Partially Supported Configuration—Details of ASA configuration elements that can be only partially
migrated. These configuration elements include rules and objects with advanced options where the rule
or the object can be migrated without the advanced options. Review these lines, verify whether the
advanced options are supported in management center, and if so, plan to configure those options manually
after you complete the migration with the Secure Firewall migration tool.

• Object and Object Groups Conflict Resolution—Details of ASA network and service objects and
object, service, and protocol object groups that have conflicts across the contexts you are trying to migrate.
To view detailed information about these object conflicts, click the Link for Conflict Count; you can
check the reason for the conflicts and also know how the migration tool is handling the conflicts.

• Unsupported Configuration—Details of ASA configuration elements that cannot be migrated because
the Secure Firewall migration tool does not support migration of those features. Review these lines,
verify whether each feature is supported in management center, and if so, plan to configure the features
manually after you complete the migration with the Secure Firewall migration tool.

• Ignored Configuration—Details of ASA configuration elements that are ignored because they are not
supported by the management center or the Secure Firewall migration tool. The Secure Firewall migration
tool does not parse these lines. Review these lines, verify whether each feature is supported in management
center, and if so, plan to configure the features manually. Click Link for the ignored configuration
lines to view all the ignored lines.
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For more information about supported features in management center and threat defense, see Management
Center Configuration Guide.

Step 3 If thePre-Migration Report recommends corrective actions, complete those corrections on the ASA interface,
export the ASA configuration file again and upload the updated configuration file before proceeding.

Step 4 After your ASA configuration file is successfully uploaded and parsed, return to the Secure Firewall migration
tool, and click Next to continue the migration.

What to do next

Map ASA Configurations with Threat Defense Interfaces

Map ASA Configurations with Threat Defense Interfaces
The threat defense device must have an equal or greater number of physical and port channel interfaces than
those used by ASA configuration. These interfaces do not have to have the same names on both devices. You
can choose how you want to map the interfaces.

On the Map FTD Interface screen, the Secure Firewall migration tool retrieves a list of the interfaces on the
threat defense device. By default, the Secure Firewall migration tool maps the interfaces in ASA and the threat
defense device according to their interface identities. For example, the 'management-only' interface on the
ASA interface is automatically mapped to the 'management-only' interface on the threat defense device and
is unchangeable.

The mapping of ASA interface to the threat defense interface differs based on the threat defense device type:

• If the target threat defense is of native type:

• The threat defense must have equal or a greater number of used ASA interfaces or port channel
(PC) data interfaces (excluding management-only and subinterfaces in the ASA configuration). If
the number is less, add the required type of interface on the target threat defense.

• Subinterfaces are created by the secure Firewall migration tool based on physical interface or port
channel mapping.

• If the target threat defense is of container type:

• The threat defense must have equal or a greater number of used ASA interfaces, physical
subinterfaces, port channel, or port channel subinterfaces (excluding management-only in ASA
configuration). If the number is less, add the required type of interface on the target threat defense.
For example, if the number of physical interfaces and physical subinterface on the target threat
defense is 100 less than that of ASA then you can create the additional physical or physical
subinterfaces on the target threat defense.

• Subinterfaces are not created by the Secure Firewall migration tool. Only interface mapping is
allowed between physical interfaces, port channel, or subinterfaces.

Before you begin

Make sure you have connected to the management center and chosen the destination as threat defense. For
more information, see Specify Destination Parameters for the Secure Firewall Migration Tool, on page 44.
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This step is not applicable if you are migrating to a management center without a threat defense device.Note

Procedure

Step 1 If you want to change an interface mapping, click the drop-down list in the FTD Interface Name and choose
the interface that you want to map to that ASA interface.

You cannot change the mapping of the management interfaces. If a threat defense interface has already been
assigned to an ASA interface, you cannot choose that interface from the drop-down list. All assigned interfaces
are greyed out and unavailable.

You do not need to map subinterfaces. The Secure Firewall migration tool maps subinterfaces on the threat
defense device for all subinterfaces in the ASA configuration.

Step 2 When you have mapped each ASA interface to a threat defense interface, click Next.
Step 3 Use the Mapped Nameif column to validate if there are already-existing configurations in the target

management center with the same name. You can rename these if the migration tool detects configurations
with same names or proceed as is if all the entries in this column turn green after validation.

What to do next

Map the ASA interfaces to the appropriate threat defense interface objects, security zones, and interface
groups. For more information, see Map ASA Interfaces to Security Zones, Interface Groups, and VRFs.

Map ASA Interfaces to Security Zones, Interface Groups, and VRFs

If your ASA configuration does not include Access Lists and NAT rules or if you choose not to migrate these
policies, you can skip this step and proceed to Optimize, Review and Validate the Configuration, on page 56.

Note

To ensure that the ASA configuration is migrated correctly, map the ASA interfaces to the appropriate threat
defense interface objects, security zones and interface groups, and VRFs. In an ASA configuration, access
control policies and NAT policies use interface names (nameif). In management center, those policies use
interface objects. In addition, management center policies group interface objects into the following:

• Security zones—An interface can belong to only one security zone.

• Interface groups—An interface can belong to multiple interface groups.

• VRFs—An interface can belong to only one VRF configuration.

The Secure Firewall migration tool allows one-to-one mapping of interfaces with security zones, interface
groups, and VRFs; when a security zone or interface group is mapped to an interface, it is not available for
mapping to other interfaces although the management center allows it. For more information about security
zones and interface groups in management center, see Security Zones and Interface Groups in Cisco Secure
Firewall Management Center Device Configuration Guide.

Migrating Cisco Secure Firewall ASA to Cisco Secure Firewall Threat Defense with the Migration Tool
54

ASA to Threat Defense Migration Workflow
Map ASA Interfaces to Security Zones, Interface Groups, and VRFs

https://www.cisco.com/c/en/us/td/docs/security/secure-firewall/management-center/device-config/740/management-center-device-config-74/interfaces-settings-ifcs-overview.html#concept_689708A9F2844E37AEA2534F660C0074


Procedure

Step 1 On the Map Security Zones, Interface Groups and VRFs screen, review the available interfaces, security
zones, interface groups, and VRF configurations.

Step 2 To map interfaces to security zones and interface groups that exist in management center, or that is available
in ASA configuration files as Security Zone type objects and is available in the drop-down list, do the following:
a) In the Security Zones column, choose the security zone for the interface.
b) In the Interface Groups column, choose the interface group for the interface.
c) In the VRF column, choose the VRF configurations for the interface.

If you are setting up a threat defense HA pair as part of the migration, you can add or autocreate
security zones and interface groups for both primary and secondary peers. Note that the security zones
and interface groups of the secondary peer are same as those of the primary peer.

Note

Step 3 You can manually map or auto-create the security zones, interface groups, and VRFs.
Step 4 To map the security zones, interface groups, and VRFs manually, perform the following:

a) Click Add SZ, IG & VRF.
b) In the Add SZ, IG & VRF dialog box, click the edit icon, enter the name you want to give to the VRF,

and click the green check mark. You can also edit the VRF name by clicking on the edit icon again.

If you are performing a merged-configuration migration and one of your contexts had VPN
configuration, it does not get displayed here to be mapped to an interface, because it gets migrated
to the global router directly.

Note

c) Enter the security zone name in the Security Zone column. The maximum characters allowed is 48.
Similarly, you can add an interface group.

d) Click Close.

To map the security zones and interface groups through auto-creation, perform the following:

a) Click Auto-Create.
b) In the Auto-Create dialog box, check one or both of Interface Groups and Zone Mapping.
c) Click Auto-Create.

The Secure Firewall migration tool gives these security zones the same name as the ASA interface, such as
outside or inside, and displays an "(A)" after the name to indicate that it was created by the Secure Firewall
migration tool. The interface groups have an _ig suffix added, such as outside_ig or inside_ig. In addition,
the security zones and interface groups have the same mode as the ASA interface. For example, if the ASA
logical interface is in L3 mode, the security zone and interface group that is created for the interface is also
in L3 mode.

Step 5 When you have mapped all interfaces to the appropriate security zones, interface groups, and VRFs, click
Next.
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Optimize, Review and Validate the Configuration
Before you push the migrated ASA configuration to management center, optimize and review the configuration
carefully and validate that it is correct and matches how you want to configure the threat defense device. A
flashing tab indicates that you must take the next course of action.

If you close the Secure Firewall migration tool at theOptimize, Review and Validate Configuration screen,
it saves your progress and allows you to resume the migration later. If you close the Secure Firewall migration
tool before this screen, your progress is not saved. If there is a failure after parsing, relaunching the Secure
Firewall migration tool resumes from the Interface Mapping screen.

Note

Here, the Secure Firewall migration tool fetches the Intrusion Prevention System (IPS) policies and file
policies, which are already present on the management center and allows you to associate those to the access
control rules you are migrating.

A file policy is a set of configurations that the system uses to perform Advanced Malware Protection for
networks and file control, as part of your overall access control configuration. This association ensures that
before the system passes a file in traffic that matches the conditions of the access control rule, it first inspects
the file.

Similarly, you can use an IPS policy as the system’s last line of defense before traffic is allowed to proceed
to its destination. Intrusion policies govern how the system inspects traffic for security violations and, in inline
deployments, can block or alter malicious traffic. Whenever the system uses an intrusion policy to evaluate
traffic, it uses an associated variable set. Most variables in a set represent values commonly used in intrusion
rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies
to represent IP addresses in rule suppression and dynamic rule states.

To search for specific configuration items on a tab, enter the item name in the field at the top of the column.
The table rows are filtered to display only items that match the search term.

The source ASA device may be managed by CSM or ASDM. When you enter more than one item (object or
inline values) in the source or destination address, or source or destination service, CSMor ASDMautomatically
creates an object group. The naming conventions for these object groups that are used by CSM and ASDM
are CSM_INLINE and DM_INLINE respectively.

When you opt to clear the inline grouping CSM or ASDM managed configurations, the predefined objects
are replaced with the actual object or member name. If you do not clear the CSM or ASDM managed
configurations, the predefined object names will be retained for migration.

For example, 10.21.44.189 and 10.21.44.190 are members of an object group and are renamed with the
predefined names such as object-group DM_INLINE_NETWORK_1 and object-group
DM_INLINE_NETWORK_2.

By default, the Inline Grouping option is enabled.Note

If you close the Secure Firewall migration tool at theOptimize, Review and Validate Configuration screen,
it saves your progress and allows you to resume the migration later. If you close the before this screen, your
progress is not saved. If there is a failure after parsing, relaunching the Secure Firewall migration tool resumes
from the Interface Mapping screen.

Secure Firewall Migration Tool ACL Optimization Overview
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The Secure Firewall migration tool provides support to identify and segregate ACLs that can be optimized
(disabled or deleted) from the firewall rule base without impacting the network functionality.

The ACL optimization supports the following ACL types:

• Redundant ACL—When two ACLs have the same set of configurations and rules, then removing the
non-base ACL will not impact the network. For example, if any two rule allows FTP and IP traffic on
the same network with no rules that are defined for denying access, the first rule can be deleted.

• Shadow ACL—The first ACL completely shadows the configurations of the second ACL. If two rules
have similar traffic, the second rule is not applied to any traffic as it appears later in the access list. If the
two rules specify different actions for traffic, you can either move the shadowed rule or edit any one of
the rules to implement the required policy. For example, the base rule may deny the IP traffic, and the
shadowed rule may allow FTP traffic for a given source or destination.

The Secure Firewall migration tool uses the following parameters while comparing rules for ACL optimization:

Optimization is available for the ASA only for ACP rule action.Note

• The disabled ACLs are not considered during the optimization process.

• The source ACLs are expanded into the corresponding ACEs (inline values), and then compared for the
following parameters:

• Source and Destination Zones

• Source and Destination Network

• Source and Destination Port

Click Download Report to review the ACL name and the correponding redundant and shadowed ACLs
tabulated in an Excel file. Use the Detailed ACL Information sheet to view more ACL information.

Object Optimization

The following objects are considered for object optimization during the migration process:

• Unreferenced objects—You can choose not to migrate unreferenced objects at the beginning of the
migration.

• Duplicate objects—If an object already exists on management center, instead of creating a duplicate
object, the policy is reused.

Procedure

Step 1 (Optional) On the Optimize, Review and Validate Configuration screen, click Optimize ACL in Access
Control > ACP to run the optimization code, and perform the following:
a) Click Proceed to proceed with the ACL optimization, where the identified Redundant ACLs and Shadow

ACLs rules for migration are displayed.

The time taken for analyzing the ACL optimization depends on the source configuration file size. The
estimation time is displayed.
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A report with the summary of total ACL rules considered for optimization is displayed. For more
information on optimization report and its components, see Reporting for ACL Optimization, on page
68.

TheRedundant ACL and Shadow ACL tabs appears only if there is data in the ACL optimization report.

The ACLs are displayed in both Redundant and Shadow ACLs under different base rules.

An ACL entry that is displayed under the Redundant or shadow ACL, the same is not considered
as the base ACL.

Note

b) To download the identified ACL optimization rules, click Download Report.
c) Select rules and choose Actions > Migrate as disabled or Do not migrate and apply one of the actions.
d) Click Save.

The migration operation changes from Do not migrate to disabled or vice-versa.

You can perform bulk selection of rules, using the following options

• Migrate—To migrate with default state.

• Do not Migrate—To ignore the migration of ACLs.

• Migrate as disabled—To migrate ACLs with State field set to Disable.

• Migrate as enabled—To migrate ACLs will with State field set to Enable.

Step 2 On the Optimize, Review and Validate Configuration screen, click Access Control Rules and do the
following:
a) For each entry in the table, review the mappings and verify that they are correct.

A migrated Access Policy Rule uses the ACL name as prefix and appends the ACL rule number to it to
make it easier to map back to the ASA configuration file. For example, if an ASA ACL is named
"inside_access," then the first rule (or ACE) line in the ACL will be named as "inside_access_#1." If a
rule must be expanded because of TCP or UDP combinations, an extended service object, or some other
reason, the Secure Firewall migration tool adds a numbered suffix to the name. For example, if the allow
rule is expanded into two rules for migration, they are named "inside_access _#1-1" and "
inside_access_#1-2".

For any rule that includes an unsupported object, the Secure Firewall migration tool appends an
"_UNSUPPORTED" suffix to the name.

b) If you do not want to migrate one or more access control list policies, choose the rows by checking the
box against the policy, choose Actions > Do not migrate and then click Save.

All rules that you choose not to migrate are grayed out in the table.

c) If you want to apply a management center file policy to one or more access control policies, check the
box for the appropriate rows, choose Actions > File Policy.

In the File Policy dialog, select the appropriate file policy and apply it to the selected access control
policies and click Save.

d) If you want to apply a management center IPS policy to one or more access control policies, check the
box for the appropriate rows, choose Actions > IPS Policy.

In the IPS Policy dialog, select the appropriate IPS policy and its corresponding variable set and apply it
to the selected access control policies and click Save.
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e) If you want to change the logging options for an access control rule which has logging enabled, check the
box for the appropriate row and choose Actions > Log.

In the Log dialog, you can enable logging events either at the beginning or end of a connection or both.
If you enable logging, you must opt to send the connection events either to the Event Viewer or to the
Syslog or both. When you opt to send connection events to a syslog server, you can choose the syslog
policies that are already configured on the management center from the Syslog drop-down menu.

f) If you want to change the actions for the migrated access control rules in the Access Control table, check
the box for the appropriate row and choose Actions > Rule Action.

In the Rule Action dialog from the Actions drop-down, you can either choose ACP or Prefilter tabs:

• ACP—Every access control rule has an action that determines how the system handles and logs
matching traffic. You can either perform an allow, trust, monitor, block, or block with reset action
on an access control rule.

• Prefilter—A rule's action determines how the system handles and logs matching traffic. You can
either perform a fastpath and block.

The IPS and file policies that are attached to an access control rule are automatically removed for
all rule actions except for the Allow option.

Tip

ACLRule Category—The Secure Firewall migration tool preserves the Rule sections in the CSMmanaged
ASA configuration and migrates them as ACL categories on management center.

Policy capacity and limit warning—The Secure Firewall migration tool compares the total ACE count
for the migrated rules with the supported ACE limit on the target platform.

Based on the comparison result, the Secure Firewall migration tool displays a visible indicator and a
warning message if the total count of migrated ACE exceeds threshold or if it approaches the threshold
of the supported limit of target device.

You can optimize or decide not to migrate if the rules exceed the ACE Count column. You can also
complete the migration and use this information to optimize the rules after a push on the management
center before deployment.

The Secure Firewall migration tool does not block any migration despite the warning.Note

You can filter the ACE counts in the ascending, descending, equal, greater than, and lesser than filtering
order sequence.

To clear the existing filter criteria, and to load a new search, click Clear Filter.

The order that you sort the ACL based on ACE is for viewing only. The ACLs are pushed based
on the chronological order in which they occur.

Note

Step 3 Click the following tabs and review the configuration items:

• Access Control

• Objects (Access List Objects, Network Objects, Port Objects, VPN Objects, and Dynamic-Route
Objects)

• NAT

• Interfaces

• Routes
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• DHCP

• SNMP

• Site-to-Site VPN Tunnels

• Remote Access VPN

• WebVPN

For site-to-site and remote access VPN configurations, VPN filter configurations and extended access
list objects pertaining to them are migrated and can be reviewed under the respective tabs.

Note

Access List objects displays Standard and Extended ACL used in BGP, EIGRP, and RA VPN.

If you do not want to migrate one or more NAT rules or route interfaces, check the box for the appropriate
rows, choose Actions > Do not migrate, and then click Save.

All rules that you choose not to migrate are grayed out in the table.

Step 4 (Optional) On the Network Objects and the Port Objects tabs, review all the network objects, network
groups, port objects, port groups, and their values. To rename an object or object group, select the object and
choose Actions > Rename.

• ClickOptimize Objects and Groups to optimize your list of objects before migrating them to the target
management center. Themigration tool identifies objects and groups that have the same value and prompts
you to choose which to retain.

• Click to move objects from Conflict Detected column to Objects/Groups Retained column and

click to move them back. Note that the ones that are referenced in most configurations are displayed
in bolded text.

• Click Auto Select to automatically select all the objects and groups with most number of referenes.
However, you can still manually override the autoselection and move objects between columns because
manual selection takes higher priority.

• Click Optimize. The migration tool performs the optimization and displays an optimization summary
with optimization data including retained and duplicate objects. For a detailed version of the optimization
report, refer to the postmigration report.

• Click Proceed and Validate.

The objects and groups which are not chosen to be retained are not migrated and are replaced
with the retained objects in the configurations they were used, such as in ACL and NAT
configurations. This ensures the list of objects being migrated is fully optimized and there are no
duplicate objects migrated.

Note

Step 5 (Optional) While reviewing your configuration, you can rename one or more network, port, or VPN objects
in the Network Objects tab or Port Objects tab, or the VPN Objects by choosing Actions > Rename.

Access rules and NAT policies that reference the renamed objects are also updated with new object names.

Step 6 In the Dynamic-Route Objects section, all the supported objects that are migrated are displayed:

• Policy-List
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• Prefix-List

• Route-Map

• Community List

• AS-Path

• Access-List

Step 7 In the Routes section, the following routes are displayed:

• Static—Displays all IPv4 and IPv6 static routes.

• BGP—Displays all the BGP routes.

• EIGRP—Displays all the EIGRP routes.

For EIGRP, authentication keys are obtained if the more system:running configuration is uploaded and
the keys are unencrypted. If the key is encrypted in the source configuration, you can manually provide
the key under the interface section in EIGRP. You can select the authentication type (encrypted,
unencrypted, auth, or none) and provide the key accordingly.

• ECMP—Displays all the ECMP zones and associated VRFs.

The only action which can be performed in this section is renaming the ECMP zones.Note

• PBR—Displays all the PBR routes.

Step 8 Under the DHCP tab, you can review and validate the following tabs:

• DHCP Server: Review all the IP address pools and the corresponding interfaces.

• DHCP Relay: Review the DHCP Relay server IP addresses, interfaces to which the DHCP server is
associated with, and the Relay-enabled interfaces.

• DDNS: Under DDNS Update Methods tab, review the DDNS method names, types, the DDNS update
intervals, and which records are configured to be updated by the DHCP Server (A or PTR records).

In the Select Features page, you can select either DHCP Server only or Relay and DDNS together.
Therefore, if you see configurations in the DHCP Server tab in the Optimize, Review and Validate
Configuration page, the DHCP Relay and DDNS tabs are empty.

Note

Step 9 Under the SNMP tab, you can review, validate, and work with the following tabs:

Based onwhether you have SNMPV1/V2 or SNMPV3 configurations on your ASA device, the configurations
gets displayed in SNMPV1/V2 tab or SNMPV3 tab.

SNMPV1/V2:

• Host Server Name: The hostname of the SNMP host

• IP Address: The IP address of the SNMP host

• Community String: The SNMP community string that must be provided manually. Select the host and
navigateActions >Update Community String to provide the community string. This must be the same
as the community or username that is configured for the SNMP service.
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• Validation State: The host server's validation state that will be created in the target management center

SNMPV3:

• User Name: The username for SNMP host

• Authentication Password: Click Actions to provide the authentication password for the user

• Encryption Password: Click Actions to provide the privacy password for the user

• Validation State: The user's validation state that will be created in the target management center

Step 10 In the Site-to-Site VPN Tunnels section, all the supported VPN tunnels that are migrated from ASA to
management center are displayed, and includes the following lists.

• Both crypto map and route-based (VTI) based VPN tunnels.

• VPN tunnels of authentication type preshared key and certificate-based authentication.

You must enter the values for preshared key and the PKI object for each VPN topology for validation
for all the rows. Failure to update will be marked as incomplete and the Secure Firewall migration tool
will not allow to proceed to validation.

For a live connect ASA, the preshared keys are retrieved automatically by the migration tool; for
a manually uploaded configuration, use the more system: running-config to retrieve the hidden
keys and provide them manually in the preshared Key column.

Note

Trustpoint or PKI object migration from ASA to management center is part of the pre-migration
activity and is required for successful migration of certificate-based VPN migration.

Note

Step 11 (Optional) Click Add Hub & Spoke Topology to configure a hub and spoke VPN topology using the target
threat defense as the hub node and selecting one or more ASA peer interfaces as the spoke nodes.

You can select spoke nodes of the same IKE versions only. For instance, you cannot choose one spoke
node of IKEv1 and another spoke node of IKEv2 IKE version.

Note

Based on the IKE version of the selected spoke nodes, configure or verify the following:

• IKE Version—Verify that the IKE version of the selected nodes is checked.

• Endpoints—Verify that the target threat defense device is by default selected as the hub node, the spoke
nodes you selected from the list, and their VPN interfaces and protected source and remote networks.
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• IKE

• IKEv1 Settings or IKEv2 Settings

• Authentication Type—The two supported authentication methods are preshared key and
certificate. See Deciding Which Authentication Method to Use in the Cisco Secure Firewall
Management Center Device Configuration Guide.

• Advanced

• Enable Aggressive Mode—Select this negotiation method for exchanging key information if
the IP address is not known and DNS resolution might not be available on the devices.

• IKE Keepalive—Enable or disable this for the keepalive monitoring.

• Threshold—Specify the IKE keep alive confidence interval. This interval is the number of
seconds allowing a peer to idle before beginning keepalive monitoring. The minimum and
default interval is 10 seconds; the maximum interval is 3600 seconds.

• Retry Interval—Specify number of seconds to wait before the IKE keep alive retries. The
default is 2 seconds, the maximum is 10 seconds.
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• IPsec

• Crypto Map Type—A crypto map combines all the components required to set up IPsec security
associations (SA).When two peers try to establish an SA, theymust each have at least one compatible
crypto map entry. The IPsec security negotiation uses the proposals defined in the crypto map entry
to protect the data flows specified by that crypto map’s IPsec rules. Choose static or dynamic for
this deployment's crypto map.

• Transform Sets—Select the IPsec proposal that you want to use for the IKE version nodes you
selected.

• Enable Security Association (SA) Strength Enforcement—Check this checkbox to ensure
that the encryption algorithm used by the child IPsec SA is not stronger (in terms of the number
of bits in the key) than the parent IKE SA.

• Enable Reverse Route Injection—Check this checkbox to enable reverse route injection
which automatically inserts static routes into routing for networks and hosts, which are protected
by a remote tunnel group list.

• Enable Perfect Forward Secrecy—Check this checkbox to generate and use a unique session
key for each encrypted exchange. The unique session key protects the exchange from subsequent
decryption, even if the entire exchange was recorded and the attacker has obtained the preshared
or private keys used by the endpoint devices.

• Modulus Group—Choose the Diffie-Hellman group to use for deriving a shared secret between
the two IPsec peers without transmitting it to each other. A larger modulus provides higher security
but requires more processing time. The two peers must have amatchingmodulus group. See Deciding
Which Diffie-Hellman Modulus Group to Use in the Cisco Secure Firewall Management Center
Device Configuration Guide for more information.

• Lifetime Duration—The number of seconds you want a security association to exist before expiring.
The default is 28,800 seconds.
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• Lifetime Size—The volume of traffic (in kilobytes) that can pass between IPsec peers using a given
security association before it expires. The default is 4,608,000 kilobytes. Infinite data is not allowed.

Step 12 In theRemote Access VPN section, all objects corresponding to remote access VPN are migrated from ASA
to the management center, and are displayed:

• Anyconnect Packages: Retreive the AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan
Package), External Browser package, and AnyConnect profiles should be retrieved from the source ASA
device for migration.

As part of the premigration activity, upload all the AnyConnect packages to the management center. You
can upload AnyConnect profiles either directly to the management center or from the Secure Firewall
migration tool.

Select pre-existing AnyConnect, Hostscan, or external browser packages retrieved from themanagement
center. You must select atleast one AnyConnect package. You must also select the Hostscan, dap.xml,
data.xml, or external browser, if they are available in the source configuration. AnyConnect profiles are
optional.

Ensure that the correct Dap.xml file is retrieved from the source firewall. Validations are performed on
the dap.xml file that are available in the configuration file. You must select all the files that are required
for validation and upload them. Failure to update marks as incomplete and the Secure Firewall migration
tool does not proceed with validation.

• AAA—Authentication servers of Radius, LDAP, AD, LDAP, SAML, and Local Realm type are displayed.
Update the keys for all AAA servers. From Secure Firewall migration tool 3.0, the preshared keys are
retrieved automatically for a Live Connect ASA. You can also upload the source configuration with the
hidden keys using more system: running-config file. To retrieve the AAA authentication key in clear
text format, follow the below steps:

These steps should be performed outside the Secure Firewall migration tool.Note

a. Connect to the ASA through the SSH console.

b. Enter the more system:running-config command.

c. Go to the aaa-server and local user section to find all the AAA config and the respective key values
in clear text format.

ciscoASA#more system:running-config

!

aaa-server Test-RADIUS (inside) host 2.2.2.2

key <key in clear text> <-----The radius key is now displayed in clear text
format.

aaa-server Test-LDAP (inside) host 3.3.3.3

ldap-login-password <Password in clear text> <-----TheLDAP/AD/LDAPS password is now

displayed in clear text format.

username Test_User password <Password in clear text> <-----The Local user
password is shown in clear text.

If the password for the local user is encrypted, you can internally check for the password or
configure a new one on the Secure Firewall migration tool.

Note
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• LDAPS requires domain on management center. You must update domain for encryption type LDAPS.

• Unique AD Primary Domain is required on management center for an AD server. If a unique domain is
identified, it will be displayed on the Secure Firewall migration tool. If conflict is found, you must enter
a unique AD primary domain to push the objects successfully.

For AAA server with encryption set to LDAPS, ASA supports IP and hostname or domain but the
management center supports only hostname or domain. If ASA config contains hostname or domain, it
is retrieved and displayed. If ASA config contains the IP address for LDAPS, enter a domain in theAAA
section under Remote Access VPN. You must enter the domain that can be resolved to the IP address
of the AAA server.

For AAA server with type AD (server-type is Microsoft in ASA config), AD Primary Domain is a
mandatory field to be configured on a management center. This field is not configured separately on
ASA and extracted from the LDAP-base-dn config on ASA.

If the ldap-base-dn is: ou=Test-Ou,dc=gcevpn,dc=com

The AD Primary Domain is the field starting with dc, with dc=gcevpn, and dc=com that forms the
primary domain. The AD primary domain would be gcevpn.com.

LDAP-base-dn example file:

cn=asa,OU=ServiceAccounts,OU=abc,dc=abc,dc=com:

Here, dc=abc, and dc=com will be combined as abc.com to form the AD Primary Domain.

cn=admin, cn=users, dc=fwsecurity, dc=cisco, dc=com:

AD Primary Domain is fwsecurity.cisco.com.

AD Primary Domain is retrieved automatically and displayed on the Secure Firewall migration tool.

AD Primary Domain value needs to be unique for each Realm object. In case a conflict is detected
or if the Firewall Migration Tool is unable to find the value in the ASA config, you are requested
to enter an AD Primary Domain for the specific server. Enter the AD Primary Domain to validate
the configuration.

Note

• Address Pool—Review all the IPv4 and IPv6 pools that are displayed here.

• Group-Policy—Select or remove the user profile, management profile, and client module profile from
this area, which displays group policies with client profiles, management profiles, client modules, and
group policies without profiles. If a profile was added in the AnyConnect file area, it is displayed as
preselected. You can select or remove the user profile, management profile, and client module profile.

The custom attribute related to the specific group-policy is displayed in the AnyConnect Custom
Attribute tab. You can select the custom attribute and validate it.

• Connection Profile—Review all connection profiles/tunnel groups that are displayed here.

• Trustpoints—Trustpoint or PKI object migration from the ASA to the management center is part of the
premigration activity and is required for successful migration of remote access VPN. Map the trustpoint
for Global SSL, IKEv2, and interfaces in the Remote Access Interface section to proceed with the
migration. Global SSL and IKEv2 Trustpoint are mandatory if the LDAPS protocol is enabled.

If a Security Assertion Markup Language (SAML) object exists, the trustpoint for the SAML IDP and
SP can be mapped in the SAML section. SP certificate upload is optional. Trustpoints can be overridden
for a specific tunnel group. If the overriden SAML trustpoint configuration is available in the source
ASA, it can be selected under Override SAML.
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For information on exporting PKI certificates from ASA, see Export PKI Certificate from ASA and
Import into Management Center.

• Certificate Maps—Certificate maps are displayed here.

• VPN Load Balancing—VPN load balancing Configurations are displayed here.

For VPN load balancing, the Secure Firewall migration tool will fetch the encryption key ifmore system:
running-config configuration is uploaded. You can manually update the encryption key usingActions >
Update Keys.

• Under the WebVPN tab, the migration tool lists all the WebVPN policies that it detected in the source
ASA device. WebVPN policies include any ASA group policy with SSL clientless VPN tunnel protocol
configurations and tunnel groups that are referenced to policies using SAML authentication. Ensure you
review the tabs associated with your WebVPN configurations before proceeding:

• Zero Trust Application Policy: Provide a different value by selecting the policy and navigating
Actions > Update Zero Trust Policy fields

• Policy Name: The policy's name that will get migrated.

• Domain Name: User-defined domain name that must be manually provided. This domain
name resolves to the threat defense interface from where the private applications are accessed.
The domain name is used to generate the ACSURL for all private applications in an Application
Group.

• Identity Certificate: The identity certificate that you imported into the target management
center before migration. This must be done as part of the premigration tasks.

• Security Zones: The corresponding security zones associated with the policy.

• Global Port Pool: The port range for the policy. A unique port from this pool is assigned to
each application.

• Application Group

• Application Group: Review the Application Group Settings including application group
name, re-authentication interval, and security zones.

Under the SAML IdP Metadata tab, you can choose to manually configure application group
name, entity ID for the service provider, single sign-on URL for the SAML identity provider
(IdP), and IdP certificate or choose Configure Later

The Applications tab lets you review or configure application-specific settings such as
application name, external URL, application URL, application certificate, and application
group.

• Standalone Applications: Review or configure Application Settings for standalone applications,
including application name, external URL, application URL, application certificate, re-authentication
interval, and security zones. The SAML IdP Metadata tab lets youmanually configure IdPmetadata
settings for standalone applications or configure later. The tabs include application group name,
entity ID, single sign-on URL, and IdP certificate.

To update the fields, click Actions and choose to update the various fields.

After the migration is successful, ensure you do a thorough review of the configurations that you migrated
to the management center and when ready, deploy it to your threat defense device.

Migrating Cisco Secure Firewall ASA to Cisco Secure Firewall Threat Defense with the Migration Tool
67

ASA to Threat Defense Migration Workflow
Optimize, Review and Validate the Configuration



Step 13 (Optional) To download the details for each configuration item in the grid, click Download.
Step 14 After you have completed your review, clickValidate. Note that the mandatory fields that need your attention

keeps flickering until you enter values in them. The Validate button gets enabled only after all the mandatory
fields are filled.

During validation, the Secure Firewall migration tool connects to management center, reviews the existing
objects, and compares those objects to the list of objects to be migrated. If an object already exists in
management center, the Secure Firewall migration tool does the following:

• If the object has the same name and configuration, the Secure Firewall migration tool reuses the existing
object and does not create a new object in management center.

• If the object has the same name but a different configuration, the Secure Firewall migration tool reports
an object conflict.

You can view the validation progress in the console.

Step 15 When the validation is complete, if the Validation Status dialog box shows one or more object conflicts, do
the following:
a) Click Resolve Conflicts.

The Secure Firewall migration tool displays a warning icon on either or both of the Network Objects or
Port Objects tab, depending upon where the object conflicts were reported.

b) Click the tab and review the objects.
c) Check the entry for each object that has a conflict and choose Actions > Resolve Conflicts.
d) In the Resolve Conflicts window, complete the recommended action.

For example, youmight be prompted to add a suffix to the object name to avoid a conflict with the existing
management center object. You can accept the default suffix or replace it with one of your own.

e) Click Resolve.
f) When you have resolved all object conflicts on a tab, click Save.
g) Click Validate to revalidate the configuration and confirm that you have resolved all object conflicts.

Step 16 When the validation is complete and the Validation Status dialog box displays the message Successfully
Validated, continue with Push the Migrated Configuration to Management Center, on page 69.

Reporting for ACL Optimization
The ACL optimization report displays the following information:

• Summary Sheet—Displays the summary of the ACL optimization.
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• Detailed ACL Information—Displays the details of base ACL. Each ACL comes with a ACL type
(Shadow or Redundant) tag to identify the base ACL for comparison and its association with the
optimization category.

Push the Migrated Configuration to Management Center
You cannot push themigrated ASA configuration to management center if you have not successfully validated
the configuration and resolved all object conflicts.
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This step in the migration process sends the migrated configuration to management center. It does not deploy
the configuration to the threat defense device. However, any existing configuration on the threat defense is
erased during this step.

Do not make any configuration changes or deploy to any device while the Secure Firewall migration tool is
sending the migrated configuration to management center.

Note

Procedure

Step 1 In the Validation Status dialog box, review the validation summary.
Step 2 Click Push Configuration to send the migrated ASA configuration to management center.

The new optimization functionality in the Secure Firewall migration tool allows you to fetch the migration
results quickly using the Search filters.

The Secure Firewall migration tool also provides support to optimize CSV download and to apply the actions
per page view or on all rules.

The Secure Firewall migration tool displays a summary of the progress of the migration. You can view detailed,
line-by-line progress of which the components that are being pushed to management center in the console.

Step 3 After the migration is complete, click Download Report to download and save the post-migration report.

Copy of the Post-Migration Report is also saved in the Resources folder in the same location as the
Secure Firewall migration tool.

Step 4 If your migration failed, review the post-migration report, log file, and unparsed file carefully to understand
what caused the failure.

You can also contact the support team for troubleshooting.

Migration Failure Support

If the migration is unsuccessful, contact Support.

a. On the Complete Migration screen, click the Support button.

The Help support page appears.

b. Check the Support Bundle check box and then select the configuration files to download.

The Log and dB files are selected for download by default.Note

c. Click Download.

The support bundle file is downloaded as a .zip to your local path. Extract the Zip folder to view the log
files, DB, and the Configuration files.

d. Click Email us to email the failure details for the technical team.

You can also attach the downloaded support files to your email.

e. Click Visit TAC page to create a TAC case in the Cisco support page.
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You can open a TAC case at any time during the migration from the support page.Note

Review the Post-Migration Report and Complete the Migration
The Post-migration report provides details on ACL count under various categories, ACL optimization, and
the overall view of optimization performed on the configuration file. For more information, see Optimize,
Review and Validate the Configuration, on page 56

Review and verify the objects:

• Category

• Total ACL rules (Source Configuration)

• Total ACL rules considered for Optimization. For example, Redundant, Shadow, and so on.

• ACL Count for optimization gives the total number of ACL rules counted before and after Optimization.

If you have missed to download the Post-Migration Reports during migration, use the following link to
download:

Post-Migration Report Download Endpoint—http://localhost:8888/api/downloads/post_migration_summary_
html_format

You can download the reports only when the Secure Firewall migration tool is running.Note

Procedure

Step 1 Navigate to where you downloaded the Post-Migration Report.
Step 2 Open the post-migration report and carefully review its contents to understand how your ASA configuration

was migrated:

• Migration Summary—A summary of the configuration that was successfully migrated from ASA to
threat defense, including information about the ASA interface, management center hostname and domain,
target threat defense device (if applicable), and the successfully migrated configuration elements.

• Selective Policy Migration—Details of the specific ASA feature selected for migration are available
within three categories - Device Configuration Features, Shared Configuration Features, and Optimization.

• ASA Interface to Threat Defense Interface Mapping—Details of the successfully migrated interfaces
and how you mapped the interfaces on the ASA configuration to the interfaces on the threat defense
device. Confirm that these mappings match your expectations.

This section is not applicable for migrations without a destination threat defense device or if
Interfaces are not selected for migration.

Note

• Source Interface Names to Threat Defense Security Zones and Interface Groups—Details of the
successfully migrated ASA logical interfaces and name and how you mapped them to security zones and
interface groups in threat defense. Confirm that these mappings match your expectations.
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This section is not applicable if Access Control Lists and NAT are not selected for migration.Note

• Object Conflict Handling—Details of the ASA objects that were identified as having conflicts with
existing objects in management center. If the objects have the same name and configuration, the Secure
Firewall migration tool reused the management center object. If the objects have the same name but a
different configuration, you renamed those objects. Review these objects carefully and verify that the
conflicts were appropriately resolved.

• Access Control Rules, NAT, and Routes You Chose Not to Migrate—Details of the rules that you
choose not to migrate with the Secure Firewall migration tool. Review these rules that were disabled by
the Secure Firewall migration tool and were not migrated. Review these lines and verify that all the rules
you choose are listed in this section. If desired, you can configure these rules manually.

• Partially Migrated Configuration—Details of the ASA rules that were only partially migrated, including
rules with advanced options where the rule could be migrated without the advanced options. Review
these lines, verify whether the advanced options are supported in management center, and if so, configure
these options manually.

• Unsupported Configuration—Details of ASA configuration elements that were not migrated because
the Secure Firewall migration tool does not support migration of those features. Review these lines,
verify whether each feature is supported in threat defense. If so, configure those features manually in
management center.

• Expanded Access Control Policy Rules—Details of ASA access control policy rules that were expanded
from a single ASA Point rule into multiple threat defense rules during migration.

• Actions Taken on Access Control Rules

• Access Rules You Chose Not to Migrate—Details of the ASA access control rules that you choose
not to migrate with the Secure Firewall migration tool. Review these lines and verify that all the
rules you choose are listed in this section. If desired, you can configure these rules manually.

• Access Rules with Rule Action Change—Details of all Access Control Policy Rules that had ‘Rule
Action’ changed using the Secure Firewall migration tool. The Rule Action values are - Allow,
Trust, Monitor, Block, Block with reset. Review these lines and verify that all the rules you choose
are listed in this section. If desired, you can configure these rules manually.

• Access Control Rules that have IPS Policy and Variable Set Applied—Details of all ASA access
control policy rules that have IPS Policy applied. Review these rules carefully and determine whether
the feature is supported in threat defense.

• Access Control Rules that have File Policy Applied—Details of all ASA access control policy
rules that have File Policy applied. Review these rules carefully and determine whether the feature
is supported in threat defense.

• Access Control Rules that have Rule ‘Log’ Setting Change—Details of the ASA access control
rules that had ‘Log setting' changed using the Secure Firewall migration tool. The Log Setting values
are - False, Event Viewer, Syslog. Review these lines and verify that all the rules you choose are
listed in this section. If desired, you can configure these rules manually.

• Access Control Rules that have failed Zone-lookup—Details of the ASA access control rules
that fail the Route-lookup operation and that is populated in the Post-Migration Report. The Secure
Firewall migration tool performs the route-lookup operation based on the route (static and connected)
information in the source configuration to populate the destination security zones in the access rules.
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• Access Control Rules for Tunneled Protocols—Details of Tunnel rules that are migrated as a
prefilter tunnel rule during migration.

An unsupported rule that was not migrated causes issues with unwanted traffic getting through your
firewall. We recommend that you configure a rule in management center to ensure that this traffic is
blocked by threat defense.

Note

If it requires you to apply IPS or file policy to ACL in the Review and Validate page, you are highly
recommended to create a policy on the management center before migration. Use the same policy, as
the Secure Firewall migration tool fetches the policy from the connected management center. Creating
a new policy and assigning it to multiple policies may degrade the performance and may also result
in a push failure.

Note

For more information about supported features in management center and threat defense, see Management
Center Configuration Guide, Version 6.2.3.

Step 3 Open the Pre-Migration Report and make a note of any ASA configuration items that you must migrate
manually on the threat defense device.

Step 4 In management center, do the following:
a) Review the migrated configuration for the threat defense device to confirm that all expected rules and

other configuration items, including the following, were migrated:

• Access control lists (ACL)

• Network Address Translation rules

• Port and network objects

• Routes

• Interfaces

• IP SLA objects

• Object Group Search

• Time-based objects

• VPN objects

• Site-to-Site VPN Tunnels

• Dynamic Route objects

b) Configure all partially supported, unsupported, ignored, and disabled configuration items and rules that
were not migrated.

For information on how to configure these items and rules, see the Management Center Configuration
Guide. The following are examples of configuration items that require manual configuration:

• Platform settings, including SSH and HTTPS access, as described in Platform Settings for Threat
Defense

• Syslog settings, as described in Configure Syslog

• Dynamic routing, as described in Routing Overview for Threat Defense
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• Service policies, as described in FlexConfig Policies

• VPN configuration, as described in Threat Defense VPN

• Connection log settings, as described in Connection Logging

Step 5 After you have completed your review, deploy the migrated configuration from management center to the
threat defense device.

Verify that the data is reflected correctly in the Post-Migration Report for unsupported and partially supported
rules.

The Secure Firewall migration tool assigns the policies to the threat defense device. Verify that the changes
are reflected in the running configuration. To help you to identify the policies that are migrated, the description
of those policies includes the hostname of the ASA configuration.

Uninstall the Secure Firewall Migration Tool
All components are stored in the same folder as the Secure Firewall migration tool.

Procedure

Step 1 Navigate to the folder where you placed the Secure Firewall migration tool.
Step 2 If you want to save the logs, cut or copy and paste the log folder to a different location.
Step 3 If you want to save the pre-migration reports and the post-migration reports, cut or copy and paste the

resources folder to a different location.
Step 4 Delete the folder where you placed the Secure Firewall migration tool.

The log file is associated with the console window. If the console window for the Secure Firewall
migration tool is open, the log file and the folder cannot be deleted.

Tip

Sample Migration: ASA to Threat Defense 2100

Create a test plan that you can run on the target device after you complete the migration.

• Pre-Maintenance Window Tasks

• Maintenance Window Tasks

Note
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Pre-Maintenance Window Tasks

Before you begin

Make sure you have installed and deployed a management center. For more information, see the appropriate
Management Center Hardware Installation Guide and the appropriate Management Center Getting Started
Guide.

Procedure

Step 1 Use the show running-config command for the ASA device or context that you are migrating and save a
copy of the ASA configuration. See View the Running Configuration.

Alternately, use Adaptive Security Device Manager (ASDM) for the ASA device or context that you want to
migrate and choose File > Show Running Configuration in New Window to obtain the configuration file.

For a multi context ASA, you can use the show tech-support command to obtain the configuration
for all the contexts in a single file.

Note

Step 2 Review the ASA configuration file.
Step 3 Deploy the Firepower 2100 series device in your network, connect the interfaces and power on the appliance.

For more information, see Cisco Threat Defense for the 2100 Series Using Management Center Quick Start
Guide.

Step 4 Register the Firepower 2100 series device to be managed by the management center.

For more information, see Add Devices to the Management Center.

Step 5 (Optional) If your source ASA configuration has port channels, create port channels (EtherChannels) on the
target Firepower 2100 series device.

For more information, see Configure EtherChannels and Redundant Interfaces.

Step 6 Download and run themost recent version of the Secure Firewall migration tool from https://software.cisco.com/
download/home/286306503/type.

For more information, see Download the Secure Firewall Migration Tool from Cisco.com, on page 35.

Step 7 When you launch the Secure Firewall migration tool, and specify destination parameters, make sure that you
select the Firepower 2100 series device that you registered to the management center.

For more information, see Specify Destination Parameters for the Secure Firewall Migration Tool, on page
44.

Step 8 Map the ASA interfaces with the threat defense interfaces.

The Secure Firewall migration tool allows you to map an ASA interface type to the threat defense
interface type.

Note

For example, you can map a port channel in ASA to a physical interface in threat defense.

For more information, see Map ASA Configurations with Threat Defense Interfaces.
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Step 9 While mapping logical interfaces to security zones, clickAuto-Create to allow the Secure Firewall migration
tool to create new security zones. To use existing security zones, manually map the ASA logical interfaces
to the security zones.

For more information, see Map ASA Interfaces to Security Zones, Interface Groups, and VRFs.

Step 10 Follow the instructions of this guide to sequentially review and validate the configuration to be migrated, and
then push the configuration to the management center.

Step 11 Review the Post Migration report, manually setup and deploy other configurations to the threat defense and
complete the migration.

For more information, see Review the Post-Migration Report and Complete the Migration, on page 71.

Step 12 Test the Firepower 2100 series device using the test plan that you would have created while planning for
migration.

Maintenance Window Tasks

Before you begin

Make sure you have completed all the tasks that must be performed before the maintenance window. See
Pre-Maintenance Window Tasks, on page 75.

Procedure

Step 1 Connect to the ASA through the SSH console and switch to the interface configuration mode.
Step 2 Shutdown the ASA interfaces using the shutdown command.
Step 3 (Optional) Access the management center and configure dynamic routing for the Firepower 2100 series device.

For more information, see Dynamic Routing.

Step 4 Clear the Address Resolution Protocol (ARP) cache on the surrounding switching infrastructure.
Step 5 Perform basic ping tests from surrounding switching infrastructure to the Firepower 2100 series device interface

IP addresses, to make sure that they are accessible.
Step 6 Perform basic ping tests from devices which require layer 3 routing to Firepower 2100 series device interface

IP addresses.
Step 7 If you are assigning a new IP address to the Firepower 2100 series device and not reusing the IP address

assigned to the ASA perform the following steps:

a. Update any static routes which refer to the IP address, so that they now point to the Firepower 2100 series
device IP address.

b. If you are using routing protocols, ensure that neighbors see the Firepower 2100 series device IP address
as the next hop for expected destinations.

Step 8 Run a comprehensive test plan and monitor logs within the managing management center for your Firepower
2100 device.
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C H A P T E R 3
Cisco Success Network-Telemetry Data

• Cisco Success Network - Telemetry Data, on page 77

Cisco Success Network - Telemetry Data
Cisco Success Network is an always-on usage information andmetrics collection feature in the Secure Firewall
migration tool, which collects and trasmits usage statistics through a secure cloud connection between the
migration tool and the Cisco cloud. These statistics help us provide additional support on unused features and
also improve our products. When you initiate a migration process in the Secure Firewall migration tool, the
corresponding telemetry data file is generated and stored in a fixed location.

When you push the migrated ASA configuration to management center, the push service reads the telemetry
data file from the location and deletes it after the data is successfully uploaded to the cloud.

Themigration tool provides two options to choose from, for streaming telemetry data—Limited andExtensive.

With Cisco Success Network set to Limited, the following telemetry data points are collected:

Table 3: Limited Telemetry

Example ValueDescriptionData Point

2023-04-25 10:39:19The time and date when the
telemetry data is collected

Time

ASAThe source device typeSource Type

ASA5585-SSP-10, 5969MBRAM,
CPU Xeon 5500 series 2000 MHz,
1 CPU (4 cores)

Model number of ASADevice Model Number

9.2 (1)Version of ASASource Version

6.5 or laterThe target version of management
center

Target Management Version

Management CenterThe type of target management
device, namely, management center

Target Management Type

75The version of target deviceTarget Device Version
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Example ValueDescriptionData Point

Cisco Secure Firewall Threat
Defense for VMware

The model of target deviceTarget Device Model

1.1.0.1912The version of the migration toolMigration Tool Version

SUCCESSThe status of the migration of ASA
configuration tomanagement center

Migration Status

The following tables provide information on the telemetry data points, their descriptions, and sample values,
when Cisco Success Network is set to Extensive:

Table 4: Extensive Telemetry

Example
Value

DescriptionData Point

Windows 7Operating system that runs the Secure Firewall migration tool. It could be
Windows7/Windows10 64-bit/macOS High Sierra

Operating
System

Mozilla/5.0Browser used to launch the Secure Firewall migration tool. It could be
Mozilla/5.0 or Chrome/68.0.3440.106 or Safari/537.36

Browser

Table 5: Source ASA Information

Example ValueDescriptionData Point

2023-04-25 10:39:19The time and date when the telemetry data is
collected

Time

ASAThe source device typeSource Type

JAF1528ACADSerial number of ASASource Device Serial Number

ASA5585-SSP-10,
5969 MB RAM, CPU
Xeon 5500 series
2000 MHz, 1 CPU (4
cores)

Model number of ASASource Device Model Number

9.(2)Version of ASASource Device Version

504The total number of lines in the source
configuration

Source Config Counts

ROUTEDThe firewall mode configured on ASA - routed
or transparent

Firewall Mode

SINGLEThe context mode of ASA. This can be single
or multi-context.

Context Mode

ASA Config Statistics:
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Example ValueDescriptionData Point

46The number of ACLs which are attached to
access group

ACL Counts

46The total number of access rulesAccess Rules Counts

17The total number of NAT rulesNAT Rule Counts

34The number of network objects configured in
ASA

Network Object Counts

6The number of network object groups in ASANetwork Object Group Counts

85The number of port objectsPort Object Counts

37The number of port object groupsPort Object Group Counts

3The total number of unsupported access rulesUnsupported Access Rules Count

0The total number of unsupported NAT access
rules

Unsupported NAT Rule Count

7The number of FQDN -based access rulesFQDN Based Access Rule Counts

1The number of time range based access rulesTime range Based Access Rule
Counts

0The number of SGT-based access rulesSGT Based Access Rule Counts

Summary of Config lines that Tool is not able to parse

68The number of config lines that are
unrecognized by the parser

Unparsed Config Count

3The total number of unparsed access rulesTotal Unparsed Access Rule Counts

More ASA config details...

falseWhether RA VPN is configured on ASAIs RA VPN Configured

falseWhether Site-to-Site VPN is configured on
ASA

Is S2S VPN Configured

falseWhether BGP is configured on ASAIs BGP Configured

falseWhether EIGRP is configured on ASAIs EIGRP Configured

falseWhether OSPF is configured on ASAIs OSPF Configured

0The number of local users configuredLocal Users Counts
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Table 6: Target Management Device (Management Center) Information

Example ValueDescriptionData Point

6.5 or laterThe target version of management centerTargetManagement Version

Management CenterThe type of target management device,
namely, management center

Target Management Type

75The version of target deviceTarget Device Version

Cisco Secure Firewall Threat
Defense for VMware

The model of target deviceTarget Device Model

1.1.0.1912The version of the migration too1Migration Tool Version

Table 7: Migration Summary

Example
Value

DescriptionData Point

Access Control Policy

Doesn't ExistThe name of access control policyName

0The total number of migrated ACL rulesAccess Rule Counts

3The total number of partially migrated ACL rulesPartiallyMigratedACLRule Counts

0The number of expanded ACP rulesExpanded ACP Rule Counts

NAT Policy

Doesn't ExistThe name of NAT policyName

0The total number of migrated NAT rulesNAT Rule Counts

0The total number of partially migrated NAT rulesPartiallyMigrated NATRule Counts

More migration details...

0The number of updated interfacesInterface Counts

0The number of updated subinterfacesSub Interface Counts

0The number of static routesStatic Routes Counts

34The number of objects createdObjects Counts

6The number of object groups createdObject Group Counts

0The number of interface groups createdInterface Group Counts

3The number of security zones createdSecurity Zone Counts

21The number of objects reusedNetwork Object Reused Counts
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Example
Value

DescriptionData Point

1The number of objects that are renamedNetwork Object Rename Counts

0The number of port objects that are reusedPort Object Reused Counts

0The number of port objects that are renamedPort Object Rename Counts

Table 8: Secure Firewall Migration Tool Performance Data

Example
Value

DescriptionData Point

14The time taken to parse ASA configuration lines (in minutes)Conversion Time

592The total time taken for end-to-end migration (in minutes)Migration Time

7The time taken to push the final configuration (in minutes)Config Push Time

SUCCESSThe status of the migration of ASA configuration to management centerMigration Status

nullThe error message as displayed by the Secure Firewall migration toolError Message

nullThe description about the stage when the error has occurred and the
possible root cause

Error Description

Telemetry ASA Example File

The following is an example of a telemetry data file on the migration of ASA configuration to threat defense:
{
"metadata": {
"contentType": "application/json",
"topic": "migrationtool.telemetry"

},
"payload": {
"asa_config_stats": {
"access_rules_counts": 46,
"acl_counts": 46,
"fqdn_based_access_rule_counts": 7,
"is_bgp_configured": false,
"is_eigrp_configured": false,
"is_multicast_configured": false,
"is_ospf_configured": false,
"is_pbr_configured": false,
"is_ra_vpn_configured": false,
"is_s2s_vpn_configured": false,
"is_snmp_configured": false,
"local_users_counts": 0,
"nat_rule_counts": 17,
"network_object_counts": 34,
"network_object_group_counts": 6,
"port_object_counts": 85,
"port_object_group_counts": 37,
"sgt_based_access_rules_count": 0,
"timerange_based_access_rule_counts": 1,
"total_unparsed_access_rule_counts": 3,
"unparsed_config_count": 68,
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"unsupported_access_rules_count": 3,
"unsupported_nat_rule_count": 0

},
"context_mode": "SINGLE",
"error_description": null,
"error_message": null,
"firewall_mode": "ROUTED",
"migration_status": "SUCCESS",
"migration_summary": {
"access_control_policy": [
[
{
"access_rule_counts": 0,
"expanded_acp_rule_counts": 0,
"name": "Doesn't Exist",
"partially_migrated_acl_rule_counts": 3

}
]

],
"interface_counts": 0,
"interface_group_counts": 0,
"nat_Policy": [
[
{
"NAT_rule_counts": 0,
"name": "Doesn't Exist",
"partially_migrated_nat_rule_counts": 0

}
]

],
"network_object_rename_counts": 1,
"network_object_reused_counts": 21,
"object_group_counts": 6,
"objects_counts": 34,
"port_object_rename_counts": 0,
"port_object_reused_counts": 0,
"security_zone_counts": 3,
"static_routes_counts": 0,
"sub_interface_counts": 0

},
"migration_tool_version": "1.1.0.1912",
"source_config_counts": 504,
"source_device_model_number": " ASA5585-SSP-10, 5969 MB RAM, CPU Xeon 5500 series

2000 MHz, 1 CPU (4 cores)",
"source_device_serial_number": "JAF1528ACAD",
"source_device_version": "9.6(2)",
"source_type": "ASA",
"system_information": {
"browser": "Chrome/69.0.3497.100",
"operating_system": "Windows NT 10.0; Win64; x64"

},
"target_device_model": "Cisco Firepower Threat Defense for VMWare",
"target_device_version": "75",
"target_management_type": "Management Center",
"target_management_version": "6.2.3.3 (build 76)",
"time": "2018-09-28 18:17:56",
"tool_performance": {
"config_push_time": 7,
"conversion_time": 14,
"migration_time": 592

}
},
"version": "1.0"

}
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C H A P T E R 4
Troubleshooting Migration Issues

• Troubleshooting for the Secure Firewall Migration Tool, on page 83
• Logs and Other Files Used for Troubleshooting, on page 84
• Troubleshooting ASA File Upload Failures, on page 84

Troubleshooting for the Secure Firewall Migration Tool
A migration typically fails during the ASA configuration file upload or during the push of the migrated
configuration to management center.

Some of the common scenarios where the migration process fails are:

• Unknown or invalid characters in the ASA configuration file

• Incomplete or missing elements in the ASA configuration file

• Loss of network connectivity or latency

Secure Firewall Migration Tool Support Bundle

The Secure Firewall migration tool provides the option to download a support bundle to extract valuable
troubleshooting information like log files, DB, and configuration files. Perform the following:

1. On the Complete Migration screen, click the Support button.

The Help support page appears.

2. Check the Support Bundle check box and then select the configuration files to download.

The Log and dB files are selected for download by default.Note

3. Click Download.

The support bundle file is downloaded as a .zip to your local path. Extract the Zip folder to view the log
files, DB, and the Configuration files.

4. Click Email us to email the failure details for the technical team.

You can also attach the downloaded support files to your email.
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5. Click Visit TAC page to create a TAC case in the Cisco support page.

You can open a TAC case at any time during the migration from the support page.Note

Logs and Other Files Used for Troubleshooting
You can find information that is useful for identifying and troubleshooting issues in the following files.

LocationFile

<migration_tool_folder>\logsLog file

<migration_tool_folder>\resourcesPre-migration report

<migration_tool_folder>\resourcesPost-migration report

<migration_tool_folder>\resourcesunparsed file

<migration_tool_folder>\resources\telemetry_datatelemetry_sessionid_timestamp.json

Troubleshooting ASA File Upload Failures
If your ASA configuration file fails to upload, the reason is typically because the Secure Firewall migration
tool could not parse one or more lines in the file.

You can find information about the errors that caused the upload and parsing failure in the following locations:

• Error message displayed by the Secure Firewall migration tool—Provides a high-level summary of what
caused the failure.

• Log file—Search on the word "error" to view the reason for the failure.

Troubleshooting Example for ASA: Cannot Find Member of Object Group
In this example, the ASA configuration file upload and parsing that is failed because the parser could not find
one of the members of an object group.

Procedure

Step 1 Review the error messages to identify the problem.

This failure generated the following error messages:

Error MessageLocation

N/AMigration Tool message
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Error MessageLocation

Line#2[ERROR] group-object GROUP1

Line#3[ERROR] group-object GROUP2

Line#1[ERROR] object-group network NOV-SERVERS

Configuration Lines with Errors
section of the pre-migration report

[INFO | object_group_mode.py:9491 > Parsing object-group network:
[NOV-SERVERS]

[ERROR | object_group_mode.py:1048 ] [GROUP1] group not found
when creating object-group network [NOV-SERVERS]

[ERROR | object_group_mode.py:1049 ] no rowwas found for one()

[ERROR | object_group_mode.py:1048 ] [GROUP2] group not found
when creating object-group network [NOV-SERVERS]

[ERROR | object_group_mode.py:1049 ] no rowwas found for one()

Log file

Step 2 Open the ASA configuration file and do the following:
a) Search for the object group by name: NOV-SERVERS

The ASA configuration file shows the following lines for NOV-SERVERS:
object-group network NOV-SERVERS

group-object GROUP1
group-object GROUP2

b) Search for each member of the group to identify which member is not included in the ASA configuration
file.

Step 3 To resolve the error, do the following using ASDM on the source ASA device:
a) Create the missing member for the object group.
b) Export the configuration file.

Step 4 If there are no more errors, upload the new ASA configuration file to the Secure Firewall migration tool and
continue with the migration.

Troubleshooting Example for ASA: List Index Out of Range
In this example, the ASA configuration file upload and parsing that is failed because of an error in the
configuration of an element that the Secure Firewall migration tool does not support.

Procedure

Step 1 Review the error messages to identify the problem.

This failure generated the following error messages:

Error MessageLocation

list index out of rangeMigration Tool message
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Error MessageLocation

N/AConfiguration Lines with Errors
section of the pre-migration report

[ERROR | asa_config_upload.py:119] > list index out of rangeLog file

Step 2 Open the unparsed file and scroll to the bottom to identify the last line of the ASA configuration file that was
successfully parsed.

In this example, the last line in the unparsed file is the following:
Line#345 [SKIPPED] address 209.165.200.224 255.255.255.224

Step 3 Open the ASA configuration file and do the following:
a) Search for address 209.165.200.224 255.255.255.224

The line that follows this one contains the configuration element that caused the issue.

b) Review the line to determine what is causing the migration to fail.

In this example, the line where the Secure Firewall migration tool had stopped parsing is name
www.example.s3.amazonaws.com. This is the line in the ASA configuration file that is directly after the
last line in the unparsed file. If you cannot identify the issue with this line, we recommend that you review
the Known Issues section in the Release Notes for the Secure Firewall Migration Tool to see if you have
encountered one of the known issues in the release.
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C H A P T E R 5
Frequently Asked Questions

• Frequently Asked Questions, on page 87

Frequently Asked Questions
Q. What are the new features supported on Secure Firewall migration tool release 4.0?
A. The following features are supported with release 4.0:

• Migration of FDM-managed device to a threat defense device managed by either the management
center or the cloud-delivered Firewall Management Center.

• Migration of Equal Cost Multi-Path (ECMP) routes from ASA.

• Migration of Policy Based Routing (PBR) from ASA.

• Migration of Remote Access VPN custom attributes and VPN load balancing from ASA.

Q. What are the new features supported on Secure Firewall migration tool release 3.0.1?
A. The following features are supported with release 3.0.1:

• Migration of Enhanced Interior Gateway Routing Protocol (EIGRP) from ASA.

• Secure Firewall 3100 series is supported as a source or destination device for ASA migrations.

Q. What are the new features supported on Secure Firewall migration tool release 3.0?
A. The following features are supported with release 3.0:

• Remote Access VPN migration

• Migration to Cloud-delivered Firewall Management Center

Q. What are the new features supported on Secure Firewall migration tool release 2.5.1?
A. The following features are supported with release 2.5.1:

• Dynamic Route objects
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• Border Gateway Protocol

Q. What are the new features supported on Secure Firewall migration tool release 2.5?
A. The following features are supported with release 2.5:

• ACL Optimization

• Wildcard mask

Q. What are the new features supported on Secure Firewall migration tool release 2.4?
A. The following ASA VPN configuration migration to threat defense:

• Crypto map (static/dynamic) based VPN from ASA

• Route-based (VTI) ASA VPN

• Certificate-based VPN migration from ASA

Q. What are the new features supported on Secure Firewall migration tool release 2.3.5?
A. The following features are supported with release 2.3.5:

• Virtual Tunnel Interface (VTI) and related configurations in Static routes, ACL.

• Route-based (VTI) VPN tunnels

Q. What are the new features supported on Secure Firewall migration tool release 2.3.4?
A. The following features are supported with release 2.3.4:

• VPN Objects

• Site-to-Site VPN Tunnels

Q. What are the source and target platforms that the Secure Firewall migration tool can migrate policy?
A. The Secure Firewall migration tool can migrate policies from supported ASA platform to threat defense

platform. For more information, see Supported Source ASA Platforms, on page 26.

Q. What are the tasks that you must perform in the Pre-Migration and Post-Migration Reports?
A. To perform the tasks as part of your plan for migrating fromASA to Firewall Threat Defense, see Sample

Migration: ASA to Threat Defense 2100 .

Q. What are the supported destination platforms versions?
A. You can use the Secure Firewall migration tool to migrate an ASA configuration to the standalone or

container instance of the Firewall Threat Defense platforms for management center 6.2.3 or later. For
more information on the list of supported devices, see Supported Target Threat Defense Platforms, on
page 27.

Q. What are the features the Secure Firewall migration tool supports for migration?
A. The Secure Firewall migration tool supports migration of L3/L4 ASA configuration to threat defense. It

also allows enabling L7 features like IPS, file policy, and so on, during the migration process.

The Secure Firewall migration tool can fully migrate the following ASA configurations:

• Network objects and groups (except discontiguous masks)

• Service objects, except for those service objects configured for a source and destination
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Though the Secure Firewall migration tool does not migrate extended service
objects (configured for a source and destination), referenced ACL and NAT rules
are migrated with full functionality.

Note

• Service object groups, except for nested service object groups, VPN objects, and ASA crypto map
VPN migration

Since nesting is not supported on the management center, the Secure Firewall
migration tool expands the content of the referenced rules. The rules, however,
are migrated with full functionality.

Note

• IPv4 and IPv6 FQDN objects and groups

• IPv6 conversion support (Interface, Static Routes, Objects, ACL, and NAT)

• Access rules that are applied to interfaces in the inbound direction and global ACL

• Auto NAT, Manual NAT, and object NAT (conditional)

• Static routes, except for those configured with the track option which are partially migrated and
ECMP routes which are not migrated

• Physical interfaces

• Subinterfaces

• Port channels

• Bridge groups (transparent mode only)

• Tunneling protocol-based access control policy rules (migrated as Prefilter tunnel rules)

• Category-based rule for CSM managed configurations

• IP SLA Monitor

• Object Group Search

• Time-based Objects

• VPN objects

• VTI interfaces

• Policy-based (Crypto Map) and Route-based (VTI) VPN tunnels

• Certificate-based VPN migration from ASA to threat defense

• Dynamic Route objects for EIGRP and BGP
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• Remote Access VPN

Q. What are the new features supported on the Secure Firewall migration tool for Release 2.2?
A. The following features are supported with release 2.2:

• Object Group Search

• IP SLA Monitor

• Time-based Objects

Q. What are the new features supported on the Secure Firewall migration tool for Release 2.0?
A. The following features are supported with release 2.0:

• Destination Zone mapping for Access Rules

• Prefilter tunnel rules

• Category-based rules

• Policy Limit and Capacity Warning

• ASA 5505 and ASA-SM migration support

Q. Is there any dependency on management center to use the new features introduced in the Secure Firewall
migration tool?

A. Yes. The following features are supported with target management center 6.5 and later:

• Migrate tunnel Rules as Prefilter

• Category-based rules

• ASA 5505 Migration

Requires management centerversion 6.5 and later to migrate to target threat
defense FPR-1010 platform.

Note

The following features are supported with target management center 6.6 and later:

• Object Group Search

• IP SLA Monitor

• Time-based Objects

• VPN Objects

• Site-to-Site VPN Tunnels

The following features are supported with target management center 6.7 and later:

• VTI interface and the related static routes.

• Route-based (VTI) Pre-Shared Key authentication type VPN configuration to management center.
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• Create routed security zone, add VTI interfaces, and then define access control rules for the decrypted
traffic control over VTI tunnel.

The following features are supported with target management center 7.1 and later:

• Dynamic Route objects

• BGP

The following features are supported with target management center 7.2 and later:

• Remote Access VPN

• EIGRP

Q. Can we migrate all the access rules in the source configuration to the Prefilter policy?
A. No. For migrations that are opted withMigrate Tunnel rules as Prefilter, the Secure Firewall migration

tool identifies tunneling protocol-based access rules and migrates them as tunnel rules.

Q. What are the features the Secure Firewall migration tool does not migrate today?
A. The Secure Firewall migration tool does not support the following ASA configurations for migration. If

these configurations are supported in management center, you can configure them manually after the
migration is complete.

• SGT-based access control policy rules

• SGT-based objects

• User-based access control policy rules

• NAT rules that are configured with the block allocation option

• Objects with unsupported ICMP type and code

• Tunneling protocol-based access control policy rules

• NAT rules that are configured with SCTP

• NAT rules that are configured with host ‘0.0.0.0’

• Tunneling protocol-based access control policy rules (supported from Secure Firewall migration
tool 2.0 with target management center 6.5 and later)

• Dynamic Crypto map based VPN

• Certificate authentication based VPN configuration
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For more information, see Guidelines and Limitations, on page 22.

Q. What are the supported source devices and code version?
A. You can use the Secure Firewall migration tool to migrate the configuration from single or multi-context

ASA platforms (software version 8.4 or later). For more information on the list of devices, see Supported
Source ASA Platforms, on page 26.

Q. Does the Secure Firewall migration tool support migration of multi-context ASA?
A. Yes. The Secure Firewall migration tool can handle migration of multi-context ASA. At any given point

in time, one can migrate one context of the ASA (except for System context) to either threat defense
container or native instances on the target management center.

Q. What is the support mechanism if there are migration errors?
A. The Secure Firewall migration tool is integrated with Cisco Success Network. If there are errors or issues,

contact Cisco TAC. For troubleshooting, see Troubleshooting Migration Issues, on page 83.

Q. How much time does the Secure Firewall migration tool take to successfully migrate a configuration?
A. The time that is taken during migration depends on numerous factors like latency on network, load on

the management center, config size, number of objects, ACL, and so on. In internal testing, it was observed
that a config file of 2.0 MB with 7000+ Access Control List, 7000+ NAT Translations, and 3000+
Network Objects takes around 6 minutes to successfully complete the migration.
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